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Introduction: Navigator, Flow Editor and Job
Viewer

This chapter discusses using the SeisSpace® interface: the Navigator, Flow
Editor and the Job Viewer. It also offers a simple workflow example to help
explain a few of the features.

Prior to following the steps in this chapter, you must first install and
complete some configuration procedures. Installing and starting the
SeisSpace user interface is discussed in the SeisSpace® Release Notes and
configuring the SeisSpace system in the System Administration guide.

Navigator

When you configure the SeisSpace system, you will define one or more
Data Homes, and each will appear in the Navigator tree view. If the tree
view in the left hand frame is blank, see Configuring the SeisSpace®
Processing System in the SeisSpace® System Administration guide.
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By default, when the Navigator is restarted, it will return to the location
where you were when you exited and it will also load any flows that were
open back into the flow editor. This behavior can be controlled by settings
in the Navigator preferences dialog from the Edit > Preference >
Navigator.

Flow Editor

The SeisSpace® Flow Editor is used to create, edit and submit flows for
execution. In the flow editor you will choose which processing steps, or
processes to include in a flow and then select process parameters. The Flow
Editor offers comprehensive editing and process manipulation capabilities.

Job Table

The Job Table tracks jobs that are submitted manually from the Flow Editor
or from the tree or table lists. You can launch the Job Table by clicking in
the Notification frame at the bottom right edge of the Navigator or by
clicking the Job Viewer icon on the icon bar.

Note: Jobs submitted via the Flow Replication Job Table are not
automatically tracked in the Job Table by default. In order to monitor the
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replica jobs in the Job Table you must select the Find > Show Replicas
option from the Job Table tool bar.

With the Job Table active, you can select a flow in the table and use the tool
bar icons or the menu bar to view the job output, kill the flow, or get other
information about the jobs.

For more information refer to Working with the Job Viewer.
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General User Interface Functions

Pull Down menus and icons

The pulldown menus and icon bars change continuously as you traverse
throughout the Navigator and Flow Editor. If you hover the mouse on an
icon, a description of its functionality appears.

You can also learn the icons by using the pulldown menus or the MB3
options menus to see a text description of the action associated with its
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icon. You will also see some hot key combination shortcuts are associated
with these actions.

Many of the main pulldown menus can be expanded using the keyboard
combination of Alt-key where the key corresponds to the underlined letter
of the top level pulldown. For example, Alt-F displays the File pulldown.
Some of the hot keys are activated by CTRL-key combinations such as
CTRL-C CTRL-X and CTRL-V for standard Copy, Cut and Paste
operations. Other hot key combinations are activated by the Alt-key
combination. You will find that only the appropriate hot key combinations
are available depending on which tab view is currently being displayed.

Mouse Buttons

MB1

MB1 selects items. Items selected with MB1 will usually be highlighted. A
single MB1 click also clears the screen in certain instances such as in the
flow editor tab. MB1 is also used for general Drag and Drop functions.
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MB2

In the Navigator from the table view of a list of datasets, MB2 will open the
Properties dialog. MB2 does have functionality in the Flow editor and,
based on preference settings, MB2 can be used to open process parameter
dialog boxes. MB2 can also be used in the Job Viewer or Replica Job Table
to get a quick look at the end of a printout of a job.

MB3

MB3 displays options or actions that can be performed on a selected item.
These options or actions are different depending on what type of item you
select. Different option lists also appear depending on where you click.

Drag and Drop

Drag and Drop is enabled throughout the Navigator and Flow Editor. Drag
and Drop is a primarily a Copy operation and not a Move operation. Drag
and Drop is only a move operation when you use it to rearrange the order
of processes within a flow in the flow editor.

Drag and Drop makes it easy to performs tasks such as:

• Copying Datasets

• Copying Flows

• Copying Processes from one flow to another

• Moving Processes around within a flow

• Selecting Processes from the Processes lists

• Copying Tables

• Copying ProMAX® Areas

• Copying ProMAX® Lines

In the Table pane you must drop the item into the empty space below the
table, onto the Name column header, or into the white "informational"
column space.

You can also drop an item from the table pane into the tree view. For
example, copying a ProMAX® flow, dataset or table from one line to
another. The drop location is sensitive to the location you are trying to drop
an object. You should also only be able to drop a Line onto an Area for
example.
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Copying Flows and how Dataset Addressing is Handled

When you copy a flow containing Disk Data Input, Disk Data Insert, Disk
Data Output, JavaSeis Framework Create, JavaSeis Data Input, JavaSeis
Sort* or JavaSeis Data Output, the dataset addressing in the flow is
adjusted as follows:

• IF a flow is copied inside the same subproject (or Line), THEN the
dataset addressing is not changed in the copied flow.

• IF a flow is copied to a different subproject (or Line) and the selected
dataset was in the same project as the original flow AND the same
dataset name exists in the project the flow is copied to, THEN the
dataset information is altered to address the local dataset in the
project into which the flow was copied.

• IF a flow is copied to a different subproject (or Line) and the selected
dataset is in the same project as the original flow AND the same
dataset name does not exist in the project that the flow is being copied
to, THEN the dataset information is reset to the default "NONE"
value.

• IF a flow is copied to a different project and the datasets were
selected from a different project than the project from which the flow
originated, THEN the dataset addressing is not changed in the copied
flow.

Sorting the Navigator Tables

The table pane can be sorted by clicking MB1 on any of the column
headers.

• Click a selected column once to sort alphabetically (or numerically)
in ascending order. Additional clicks will reverse the sort order.

• CTRL-MB1 is used to set multiple column sort criteria and a addi-
tional CTRL-MB1 clicks will reverse the direction of the sort.

• Shift-MB1 removes the sort specifications.

Quick search in a column

A MB3 click on a column header opens an options menu which includes
quick search.
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The quick search feature will allow you to find the first instance in the
column starting with the characters typed into the column header. For
example if you select Search Column and then enter a character (such as
the number "2"), the first flow that starts with 2 is highlighted.

Pressing the ESC (escape) key dismisses the Search mode.
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Column widths

Column widths can be adjusted by dragging the separators between the
column headers.

Column Re-ordering

You can re-order the columns by dragging the column headers to their new
locations.

Column Show/Hide and Size

You can select to show or hide columns. Use the Column Selector icon to
choose which columns to show.

Note: Each tab pane is treated as a separate entity. You can set different
column visibility, widths, order and sort criteria for each of the different tab
panes. The default is to have a single Navigator tab pane, but you may elect
to set the user preference to have separate tab panes for Flows, Datasets and
Tables in addition to the single Navigator tab pane.

Filtering tables

You can select which entries to display in a table using the Row Filter
option. For example, you can select only the datasets or flow of interest to
you. Use the Row Filter icon to choose criteria for selecting what to show.
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Selecting Multiple Entries in a table

You can select multiple entries and perform the same operation on them.
For example you can delete several flows in one step, or select multiple
flows to load into the editor simultaneously, or submit several jobs to the
job queue without opening the flows in the Flow Editor.

There are two ways to select multiple objects in the table. A single MB1
click will select the first, single item,

• CTRL-MB1 selects a second item.

• SHIFT-MB1 selects all of the items between the previous selection
and the current selection.
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You may also select a continuous set of objects in the table by holding
down MB1 while "painting" down the data type column. (the second
column by default). The selected objects will inherit the light blue color.
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Working with the Navigator

The Tree and Table views

The Navigator has two main frames. The tree view in the left frame and the
table view in the right frame.

The tree view shows the contents of Data Homes and their associated
project databases. Expand the projects to see their subprojects and
associated flows, datasets and tables. Open the folder in the tree view to
display the subprojects and associated files in the table pane.

The right pane displays a variety of tab pane combinations such as
Navigator, Job Table, Replica Editor and Flow Editor depending on
preferences you have selected. If you choose the preference you can have
separate tabs for Flows, Tables, and Datasets. You can use these tabs to
quickly move from one list of objects to another or to the flow editor.

Note: By default there is only one Navigator tab for all types of objects.
You can change this behavior by altering a setting in the Navigator tab of
the preferences dialog.

Table View

Tree View

Tab Panes
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Expand and contract the entries in the tree view by clicking on the symbol
to the left of the folder name.

You will see the highest level is a list of “Data Homes”. The icon with the
gray bar at the bottom indicates that this is a project that is shared by the
administrator and the properties are locked.

All other folders are shown with the standard project icon.

The one example above showing the standard icon with the Blue shading
indicates that the data home is the ARCHIVE_DATA_HOME that is used
as the default location for working with archive and restore flows.

Projects (or Data Homes)

As you continue to expand the projects, you see a list of Areas (or Projects)
under the ProMAX® data homes, Lines (or Sub-Projects) under the Areas,
and Flows, Datasets, and Tables under the Lines. Note that in the
SeisSpace® user interface, the Areas and Lines are referred to as Projects
and Subprojects.

Linking the Tree and Table views

The Tree view can be either locked or dynamically repositioned with
respect to what is selected in the Navigator table or Replica Table or
Replica Job Table views using the "Tree Lock" icon.

When this icon is "unselected" (with a gray background) the tree is locked
to the other views so that when you select something in the Table or a flow
in the flow editor, the tree will dynamically reposition to show you the
location of the selected item.

Sometimes you may not want the tree view changing as you are working.
In this case you can turn the lock off by clicking on this icon giving it a
white background.

In this mode the tree view will remain stationary as you select different
objects in the other Navigator panels.
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Editing Parameter Tables

Table editing is performed using either ProTab or geomspread (the original
ProMAX® table editor) and is enabled by choosing the Edit option from
the MB3 options menu when MB3 is depressed on a table name in the tree
or table.

Detailed documentation on using ProTab is available from the ProTab Help
menu pulldown.
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Setting Permissions

You will notice that some items may have the Lock icon next to them in the
table view.

In general, an item in the table that has a Lock icon indicates that you do
have write permission for some major component of that item.

For Projects (Data Homes), the lock icon appears when the main project
directory does not have sufficient write permissions for your user.

A ProMAX® dataset that is annotated with the Lock icon indicates that the
xxxxxxxxCIND file does not have write permission. Note: The CIND file
is the only file that is checked for ProMAX® datasets.

A JavaSeis dataset that is annotated with the lock icon indicates that the
dataset-name.js directory does not have write permission. Note: This
directory is the only check for JavaSeis datasets.

For Flows, the lock icon appears when the main flow directory does not
have sufficient write permissions for your user. Note: The main flow
directory is the only check for flows.

Tables follow the same convention. All files associated with the table must
have sufficient permissions or the entry in the list is annotated as locked.
The file that is checked is the ########XXXX file.
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Changing permissions

Use the lock icon or select Edit > Permissions from the pulldown menu or
click MB3 on the item and select Permissions from the popup to view or
modify the permissions on entire projects or subproject. You can also
change the permission on individual objects such as datasets, flows or
tables.

Note: You must be the owner of all of the files under the selected directory
for all of the permission changes to take place successfully. If you are not
the owner you will be presented with a non-editable dialog.

Files associated with datasets and flows can be owned by many different
users and the permission change is only applied to the files owned by you.

Note: The SeisSpace® user interface does not offer the ability to do batch
commands as the root user to change global ownerships.

The Permissions window shows the standard Owner, Group, and Other
read and write permissions and allows you to change the permission.

To change the permission, click the boxes that describe the desired
permissions and then click the Modify button.
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Dataset Types and Icon Descriptions

When you look a list of dataset in the Navigator in either the tree or table
view you can see a variety of different dataset types.

JavaSeis dataset that is simply a stub (Dataset added to the list with no
framework or trace data).

JavaSeis dataset that has had it’s framework defined or has been
“Emptied”. Dataset has no trace or header extent files.

JavaSeis dataset that has had it’s framework defined and has trace/header
data.

JavaSeis dataset that has had it’s framework defined, has trace/header data
and has at least one sort map generated for it.

JavaSeis dataset that has been “Emptied” but still has pre-existing sort
map(s) associated with it.
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ProMAX® dataset that is simply a stub (dataset added to the list with no
framework or trace data) or a ProMAX® dataset that has been “Emptied.”

ProMAX® dataset that has Trace and Header extent files.

ProMAX® dataset that has Trace and Header extent files and has also had a
framework file added using the Scanning tool.

GeoProbe .vol file. or Hybrid model file
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Dataset Properties / Inventory / Fold Map

From the MB3 > menu or from the icon bar you can get information about
the datasets. Of particular interest are the Dataset Properties, Inventory and
Fold Map. ProMAX® vs. JavaSeis vs. ProMAX® with framework will
have different options.

Dataset Properties

The properties information dialogs show general information about the
datasets. The properties dialog will be different for ProMAX®, ProMAX®
with framework and JavaSeis Datasets.

Despite the similarities, there are several important differences between the
Properties view is for ProMAX® and JavaSeis datasets.
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For ProMAX® datasets the properties information dialog looks like this:
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For ProMAX® datasets with a framework added, the properties
information dialog looks like this:

For JavaSeis datasets the properties information dialog looks like this:
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The main difference in these dialogs is that the information for a
ProMAX® dataset includes the minimum and maximum SIN and CDP
ranges of the datasets and the JavaSeis Framework is shown for ProMAX®
datasets with a framework and JavaSeis datasets.
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If a sort table exists for a dataset you can select the sort table and then the
framework summary will change to reflect the framework of the chosen
sort table.

Dataset Inventory

JavaSeis datasets are usually distributed over several different physical files
on a number of different disk file systems. The Inventory dialog shows a
summary of the distribution of the extents over the file systems.

Inventory: Shows the locations and distribution of the dataset extent files.

Rebuild Foldmap: If required, you can rebuild the traceMap file based on
the actual contents of the extents. We found during development that there
were cases where the traceMap file was updated as if the traces were
written, but the traces were not actually written to the file. The Rebuild
Foldmap option was added to help diagnose and fix this problem.

Space: Space can be used to get a listing of the free space available on the
secondary storage disks.

Close: Exits the dialog.

Dataset Fold Map

The Fold map is available for JavaSeis and ProMAX® datasets with
JavaSeis frameworks. This tool can be used to monitor a JavaSeis dataset as
it is being populated or as a quality control tool after a dataset write
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operation is completed. The Fold Map can also be used to check the
integrity of a dataset to see if all of the data is in the file.

Fold map Options menu:
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Histogram:

Generate a histogram plot that shows the distribution of the data
values.

Toggle background color:

Alternate between background colors of black and white.

Display min/max clip slider:

Choose to display or not display the clip limit slider bars on the right
side of the fold map display.

Update Automatically:

With this option checked "ON" the display will automatically refresh every
few seconds and update the display with the data population.

Fold map Icon Bar:

Zoom:

Enables the zooming function. Use MB1 to drag a box inside the
display or outside the display in the axis for one dimensional zoom.

UnZoom:

Click on this icon to restore the display to its original size

Zoom Unzoom
                Color Table
                          Color Clipping
                                            Refresh

                                               TraceDisplay

                                                                   3D Display
                                                                            3D picking

Pick mark control

Connect to Message Server

Shot Receiver CDP plot

Ensembles per Screen

                              SortMap selection

        Trace Fold for post stack data
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Color Table:

Choose a color table from a list.

Specify min/max clipping:

Manually set the color clipping limits.

Reload and refresh:

Refreshes the display by rereading the input dataset from disk. If you
recreate the dataset you can use this button to force a hard restart and
relocate the files and re-initialize the display.

Trace Display:

Clicking on this icon will start a SeisSpace® Trace Display. You can
display "frames" from the JavaSeis dataset selecting the locations
with MB1 clicks.

Change pick mark and cross hair appearance:

Used in the 3D picking mode to control the size of the pick marks and
the crosshair locators.

3D Viewer:

Start the 3D viewer to look at the data in the file in 3D.

3D Picking:

Start the 3D viewer and a 2D Trace display to pick mutes and design
gates using the Fold map for navigation, the 3D viewer for QC of the
table in a 3d display and the 2D viewer to pick the functions.

Turn Locator and Pick Messages On/Off:

When the Trace Display, Fold map, 3D viewer and Seismic Compare
are running together in different modes, there is a Message Server
that sends location information from one application to another. This
icon can be used to turn the message passing on and off for this
instance of the fold map so that it does not send location information
to the other application or receiver location information from other
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applications.

Display the bin grid geometry...:

For pre-stack frames this option will show a map of all of the shot,
receiver and cdp positions for all of the traces in the frame. You can
also use this feature to help define aperture distances for the prestack
imaging modules.

Display TRC_FOLD for a post stack dataset:

For post stack data you can plot the actual trace fold as a secondary plot in
addition to the “frame fold” normal fold map.

EPS (Ensembles per Screen):

Combined with the 2D Trace Display viewer sets the number of
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frames to display in Trace Display at each selected location.

Additional fold map displays based on sort tables:

The selection box allows you to choose from a list of sort tables that exist
for this dataset. Select the fold map and a new fold map based on the
selected sort table will be generated and displayed.
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Setting Preferences

Select Edit > Preferences to display the preferences window.

The tabs at the top are used to change the preferences for specific windows
within the user interface. They are discussed from left to right.
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Navigator Tab
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The Navigator tab allows you to set preferences for the Navigator.

• Automatically increment flow version when flow is saved can be
toggled on or off. With this set to Off, you will only have a single
instance of the flow saved.

• Overwrite instead of append to existing log files can be toggled on
or off if the previous setting is set off (or do not increment the flow
instances). With this set to OFF multiple runs of the flow will concat-
enate into the log file. With this set to ON, the exec.0.log file will be
replaced for each run of the flow.

• Automatically purge old flow versions can be toggled on or off. On
will limit the maximum number of flow versions at any time.

Change the Number of flow instances to keep after purge. The
default is to keep the 5 most recent versions. This also sets the
maximum number of instances to have before an auto-purge takes
effect if that option is chosen

• Automatically purge old flow replicas can be toggled on or off. On
will limit the maximum number of replica versions to have at any
time.

Change the Number of replicas to keep after purge. The default is
to keep the 2 most recent versions. This also sets the maximum
number of instances to have before an auto-purge takes effect if that
option is chosen

• Number of parallel replica builders can be use to change the num-
ber of threads used to to build replica flows. The default is 7.

• Use a single common tab for all data types: Select to reduce the
number of tabs at the top of the Navigator by using the Navigator tab
only instead of having separate tabs for Datasets, Flows, Tables, and
Navigator.

• Single mouse click opens latest instance of flow: This is a compati-
bility switch to make the Navigator act like the ProMAX® user inter-
face. That is, a single click on a flow name displays it in the flow
editor. This option takes fewer mouse clicks to get a flow into the edi-
tor. However, it is harder to get to the flow instance list. This option is
toggled On when you choose ProMAX® feel from the Defaults tab.

• Click on a single selected cell in Name column allows rename: If
this option is selected then a second click on an entry in the table
view will put that item into a rename mode. (note that this is two sep-
arate single clicks which is different from a double click)

• Prompt for the name of the copied object: If this option is selected
you will be prompted to supply a name for a copied object before the
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copy operation is performed. It this is unchecked, the "copy of" nam-
ing convention will be used automatically.

• Automatically open last selected flow on startup: This is a compat-
ibility switch to make the Navigator act like the ProMAX® user
interface. That is, the last flow you were editing when you stopped a
session is opened on startup. This option is toggled On when you
choose ProMAX® feel from the Defaults tab.

• Expand tree to last opened flows: If flows are opened you have the
option to also expand the tree to open the lists of flows for all of the
projects for which flows are opened. Leaving this box unchecked will
keep the tree view in a more compressed state.

• Restart at last opened location: You may elect to have the Navigator
automatically navigate to the last set of information you were looking
at when you exited the Navigator. The default it so start the Navigator
where it presents the lists of projects under the hosts where you
would then select which project you wanted to work on.

• Restore last archive state: If you have selected objects for archiving,
the last selection will be saved and restored the next time you go to
archive selection.

• Hide the job viewer after job submit: This is a compatibility switch
to make the Navigator act like the ProMAX® user interface. That is,
when you submit a flow the job viewer window is hidden and the job
status appears in the notification window. This option is toggled On
when you choose ProMAX® feel from the Defaults tab.

• Never calculate and display the size of data-home areas: If this
option is checked on then you will not compute the size of areas when
you click on a data home in the tree view.

• Beep after job completion: You can select to turn off the notification
"beep" of job completion status.

• Check for changes on disk when redisplaying can be toggled on or
off. On will refresh the list of datasets, flows, tables etc each time the
list is opened so that if other users have added items you will see
them. This action is similar to clicking on a node in the tree view and
then clicking the refresh icon. With this option on, the refresh icon is
automatically clicked when you choose a node.

• Attempt to automatically sort tree nodes can be toggled on or off.
On means that extra steps will be taken to try to ensure that that tree
view always stays sorted.
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• Include files whose names match this RE in a flow copy can be
used if there are non-standard files in a flow directory. Set the regular
expression to include other files to include in the copy operation.

• Order of Tree nodes can be set to control how items are listed in the
tree view.

• Size of the Toolbar Icons: Choose to use Normal or Large icons on
the toolbar.

• Scaler for the size of the UI fonts can be used to display the text in
the navigator with smaller than normal or larger than normal fonts.
The navigator will need to be restarted for the change in value to take
affect.
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Flow Editor tab

This window contains options for customizing the flow editing behavior.
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The first height and width values control the size of the flow editor window.
The Divider location is active only if the “Use dialogs instead of scrolled
list for parameters for all processes” is toggled off and controls the position
of the divider between the process list and the scrollable parameter window
components of the flow editor. You can use the “Set height and width from
the active Flow Editor” to populate these values from an active flow edit
session. The subflow height value is shown in the graphic below.

The Parameter dialog width value is used when the “Use dialogs instead of
scrolled list for parameters of all processes” is toggled on and sets the

Subflow
height

width

height

divider location
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width of the individual parameter dialog box of parameters for each
process that is shown when MB2 is clicked on a process.

Flow Editor parameters

• Flow Editor is always full size: This is a compatibility switch to
make the Navigator act like the ProMAX® user interface. The flow
editor window occupies the entire flow editor window to mimic the
ProMAX® look and feel.

• Only a single Flow Editor can be opened at a time: This is a com-
patibility switch to make the Navigator act like the ProMAX® user
interface. Only one flow is open in the flow editor at any given time.
This mimics the behavior of the ProMAX® user interface. Editing a
new flow opens a new flow editor window.

• Single-Click inserts process from list: This is a compatibility switch
to make the Navigator act like the ProMAX® user interface. Toggle
On to add a process from the processes list with a single click. Toggle
Off to add a process by either using Drag and Drop or a double click.

• Mouse buttons behave like ProMAX GUI for editing a flow: This
is a compatibility switch for mouse bindings to be similar to those in
the ProMAX® system. This option only affects MB3; toggle on for
MB3 to toggle a process back and forth between active and inactive.
Toggle Off for MB3 to popup a dialog box for the selected process.

• Middle mouse button ends selection range: This is a compatibility
switch to make the Navigator act like the ProMAX® user interface.

width

height

parameter dialog width
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Toggle On to select a range of processes using MB1 and MB2 instead
of using SHFT MB1 to select the range.

• Auto-collapse disabled processes: This option is only applicable
when using the scrollable window flow editor. Toggle On to collapse
the parameters for an inactive process.

• Gain focus when mouse enters type-in fields : With this option
checked, typein fields in menus will automatically gain mouse and
keyboard focus when you enter the field, With it un-checked you can
give the typein field focus by clicking in the text dialog. NOTE: you
will need to re-open existing flows in the editor or restart the naviga-
tor to see a change in behavior.

• Auto-select type-in fields: When the mouse moves into a type-in
files you have the choice of whether or not the current text gets put
into the temporary copy clipboard. With this option checked the text
will be added to the clipboard, with it unchecked, the text will not be
added to the clipboard. It is recommended to un-check this if you do a
lot of mouse copy with MB1 drag from one source and a MB2 drop to
copy the text from one location to another.NOTE: you will need to re-
open existing flows in the editor or restart the navigator to see a
change in behavior.

• Always expand to see all processes in the processes list: This is a
compatibility switch to make the Navigator act like the ProMAX®
user interface. Toggle On to show all processes in the processes
selection window.

• Use dialogs instead of a scrolled list of parameters for all pro-
cesses: This is a compatibility switch to make the Navigator act like
the ProMAX® user interface. Toggle on to display the flow as a sim-
ple list of processes. MB2 is used to view the parameters for the
selected process. You can have multiple parameter windows open
simultaneously.

• Automatically show parameter list for active templates: Select this
option if you want template flows to be opened with the scrollable
parameterization window as the default.

• Select Datasets and Tables from current project: Toggle Off to
navigate to the last list of datasets or tables that you visited. This is
useful if you are selecting several datasets from a different project.
This does nothing related to the general capability to select datasets
from different AREA/LINE’s within the same DATA_HOME. This
simply controls which datasets list is presented when you ask for a
list from a data input or output menu.
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• Enable Intelligent Parameterization: You can have the flow builder
automatically and instantly check some of the parameterization of the
processes as the flows are being built. The functionality is automati-
cally turned off for pure ProMAX® flows. The status of the IPM is
shown in the light bulb icon in the lower left hand corner of the navi-
gator.

• Choose Headers using their names can be toggled on or off. On
indicates that headers will be shown in menus by their attribute name.
Off indicates that headers will be shows in menus with their descrip-
tive name.

• Process AutoComplete Search Method: This is a compatibility
switch to make the Navigator act like the ProMAX® user interface.
Set to Starts With to display processes with the characters you
entered. Contains or Acronym mimics the ProMAX® user interface
in that you can type more shortcuts for a process search.

• Close Flow Editor tab behavior: choose between Do not close,  or
Automatically close when a flow editor tab is emptied of all of its
flows.
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Log Viewer tab

The Log Viewer tab configures the job printout viewer. The Buffer size
entry controls the maximum size of a printout. This is handy if you are
running the client remotely and you want to view a large printout. Only
1024 KB of the file is initially transferred. The remaining entries control
the font sizes of the viewer.
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Defaults tab

There are three basic sets of defaults: Use ProMAX® feel, Use
SeisSpace® feel and you can also Restore all standard defaults.

Under the products selection section you can choose which products you
want to make available in your product list pulldown from the Navigator.
The default is to use the list that the administrator has set up. You can
override that list for your personal settings here.
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Exec Tab

The Exec tab allows you to set preferences for the SeisSpace®
trace processing executive program.
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• Program for executing command on remote machine: If you do
not have rsh permission to run the qsub command you can select to
use ssh instead. Note: you must go through the ssh setup procedure to
allow ssh without a password prompt. This procedure is outlined in
the ProMAX® and SeisSpace® System Administration online help.

• Override virtual machine arguments: This is a a capability added
specifically for the development environment. The user has the capa-
bility to alter exec parameters to work in a debug environment. The
details of this procedure is outlined in the development class notes.
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Working with the Job Table

Overview

The Job Table shows the status of jobs submitted via the Navigator or Flow
Builder. The primary purpose of this table is to monitor jobs that are
submitted from the Flow Editor, or from the tree and table lists of flows.
Jobs that are submitted from the Flow Replication Job Table can also be
monitored here by clicking the Find > Show replicas check box.

The commonly occurring status values are:

• Completed,

• Failed,

• User Terminated,

• Running,

• Chained, and

• Queued.

The other status values are Unknown, Submitted, Initializing,
Unresponsive, Waiting_on_RSRCS, Waiting_on_Mount, Paused,
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Stopping, Cancelled, Chain_Failed and Build_Failed. Stopping occurs
when the jobs are completing. Only pure ProMAX® jobs can be in a
Paused state.

You can get a Quick View of the end of a job printout by holding down
MB2 on one of the rows of the job viewer. This shows the last few lines of
the printout for a quick QC of the job.

Job Viewer Column Headings

Name

Shows the name of the flow and its instance number.

Host/Queue

Shows the host (or list of hosts) or Queue where a job was submitted.
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Foreman

Show the foreman node. One Joblet is the foreman of the job. Usually the
first node in the execution node list.

Execs

Shows the number of joblets into which the job was divided.

Status

Shows the current status of the job.

% Data read

Shows the percent of the input data passing through the Input.

Input MB/s

Shows the rate at which data is passing through the Input.

Submitted

Shows the date and time when a job was submitted.

Initialized

Shows the date and time when a job was initialized.

Completed

Shows the date and time when a job completed.

User

Shows the user who submitted the job.

Area/Line

Shows the Area/Line with which the flow is associated.

Traces

Shows the number of traces processed by the job.

IsReplica

Shows true or false depending if the flow is a replica or not.
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Queue JobID

Shows the JobID from the Queue. Shows -1 for direct submit jobs

Job Viewer Icon Bar

The icons will be changed to a grayed out status depending on the status of
the job and the type of job that is selected.

Refresh job listing icon

The icon can be used to refresh the job listing by rereading the current
jobs.* files from the logs directory.

The icon can be used to open the Workpile Manager dialog for a template
or a replica.

View job listing icon

The icon can be used to view the printout of the selected job while it is
running or after it has completed.

Query Status of Joblets icon

This icon is only used for pure SeisSpace® or Hybrid jobs, it has no use for
pure ProMAX® jobs. The joblet status window that is started using the
"Query status of joblets" icon displays the detail of a job. The window is a
matrix display with one column per thread and several rows per process.
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Each group of rows displays statistics for a process.

Watch for large values in waiting for input or waiting to output. For
example, when a job has a low percent active and a high value in waiting
for input, it indicates that you cannot feed the data to the processors fast
enough. High values for waiting to output are very typical for all of the
processes proceeding the Prestack migration. PSTM is a very compute
intensive process and is generally in a very high CPU utilization and high
waiting for input mode.

Monitor data flow of running job icon

The job summary displays statistics about a job.

Process 1

Process 2

Process 3

Job Summary
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For SeisSpace® and Hybrid jobs, an example job status monitor is shown:

Each thread has a set of statistics for each process in the thread. You can
see bottlenecks in this window or those jobs consuming the most CPU
time.

For PSTM jobs it is very common to see that the PSTM is using a high
percentage of the CPU and causing a high percentage delay in the previous
processes.

Thread 0

Thread 1

Combined
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For ProMAX® jobs, and example job status monitor is shown:

Display final job report

Display the final job report that is available after the job completes.

Multiple job printout search

You can select multiple jobs in the table and then search all of the most
recent printout files for the same string.

After the printout viewer starts, click on the refresh icon to view the results.

Pause job and Resume Pause job icons

These icons can be used to temporarily halt a job that can be started again
later. Note: Pausing a job that was released from the Queue does NOT



Working with the Job Table55 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

mean that another job will be released while this one is paused. This
operation is valid for all types of jobs.

Stop input and finish flow normally icon

The "Stop" icon is only available for Hybrid or SeisSpace® jobs. This icon
will stop he input step of the flow but the remainder of the flow will
complete as if the input had read all of the available data. There will
generally be a delay between the time the icon is clicked and the job stops,
especially jobs that are doing a lot of computation between data reads.

Kill the job ASAP icon

This icon will terminate a ProMAX®, SeisSpace® or Hybrid job as soon
as possible. The job will not complete normally after having shut off the
input stream of data using the Stop icon.

Delete job from Job Manager permanently or Remove from the Queue
icon

This icon can be used to permanently remove jobs from the viewer. This
icon can also be used to remove jobs from the queue that are in queued
status.

Output Thread Dump for debugging

For debugging some jobs it is useful to do a thread dump on the job so that
development can try to determine where a job is having a problem.

Row Filter icon

You can select which entries to display in a table using the Row Filter
option. For example, you can select only the datasets or flow of interest to
you. Use the Row Filter icon to choose criteria for selecting what to show.

Column Show/Hide icon

You can select to show or hide columns. Use the Column Selector icon to
choose which columns to show.
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Note: Each tab pane is treated as a separate entity. You can set different
column visibility, widths, order and sort criteria for each of the different tab
panes.The default is to have a single Navigator tab pane, but you may elect
to set the user preference to have separate tab panes for Flows, Datasets and
Tables in addition to the single Navigator tab pane.
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Archive and Restore

The original ProMAX® Archive to Tape module has been removed from
the processes list as of release 5000.0.0.0. The “List/Restore from Tape”
remains in the system so you can restore legacy ctar files created in earlier
versions.

The Archive and Restore procedures are driven by selecting what you want
to archive and what you want to restore using user interface components
built into the Navigator. The Archive and Restore are driven by a
restructured “tar” protocol that handles sparse files and properly
understands the secondary storage directories.

Both the Archive and Restore procedures are driven by “wizards” to guide
you through the required steps.

There are three icons above the tree view of the Navigator related to the
Archive and Restore wizards and choosing/viewing what you want to
archive.

Toggle Archive View icon

The icon can be used to toggle the tree view between the normal view and
the Archive view which allows you to select objects to include in the
archive.

Archive Wizard icon

The icon can be used to start the Archive Wizard.

Restore Wizard icon

The icon can be used to start the Restore Wizard.

Archive Data Home

You will need to designate some Data_Home as the Archive Data Home.
There is nothing special about this Data_Home except that it has an
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Archive and Restore area in it where the archive and restore jobs are built
and saved by the Wizards. You can add an Archive Data Home using the
Edit > Administration > Add Archive Data Home pulldown menus. This
will start the standard Data Home addition dialog. If you choose an existing
project, replacing it will add the Archive and Restore areas. You can make
many Archive and Restore Areas in the different projects and then set any
of the projects to the archive data home using the MB3 - Set as Archive
Data Home option.

You must set one project as the default archive data home.

The Data Home that is the current Archive Data Home is annotated with
the Blue shaded project icon as shown above.

Archive View

Archive View can be used at any time during a Navigator session to add or
remove objects from the list of objects to be archived. A file is stored in the
users preference directory (either ~/SeisSpace or
$PROWESS_PREFS_DIR) called “.archive_state.xml”. When you run the
Archive Wizard, the first guess at what you want to archive is retrieved
from this file. This file is saved when you exit the Navigator.
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As you are using the Navigator you can toggle to the Archive View and add
something to the list while you are thinking about it, or remove things that
have either already been archived or you no longer want to archive.

You can click MB1 in the box next to the items you want to archive. A “-”
sign indicates that not everything under that directory has been chosen. A
“check mark” indicates objects that have been chosen. A check in a
directory or a datatype, such as Flows indicates that all flows, or database
files, tables, datasets, and other files below the checked object will be
archived.

Notice that there is the “Other Files” section. This will show other files that
are in the Line directory that are not recognized as system files that you can
choose to archive. If any flow is selected then the replica* files associated
with that flow will also be automatically chosen for archival. Similarly, if
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any database object is chosen then the PromaxGeom* files will
automatically be included in the archive.

You can continue to use the Navigator as normal while in the archive view
mode. Be careful where you click so you don’t accidentally include things
in the archive list you did not want or delete items that you did want.
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Archive Wizard

The six steps in running the Archive Wizard are listed in the first window.

Click on Next> to go to step 1 to select the Archive Data Home project.
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In this panel you are asked to select the Archive Data Home project and
also give a descriptive name to the archive flow that will be constructed and
executed by the wizard.

As the text describes, you can choose any project as the archive data home
using the MB3 option, but it must have already been set up as a valid
Archive Data Home with the “archive” and “restore” areas. The flows will
be written to Lines where the Line name is the current calendar year-
month.

The Line name is not under user control, but the flow names are.

After running a few archive and restore flows you will see the flows listed
in the tree view as shown in the following diagram. Notice that Project
(Area) level is Archive, the Subproject (Line) level is the current year-
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month, and the Flow names are the day of month and hour-minute-second
when the Wizard created the flow.

Click Next> to go to the next panel.

At this point you will have a new flow in the Archive Data
Home/archive/year-month/date-time directory. In the date-time flow
directory there will be a DescName file only.

In this step you are asked to finalize your selection of what you want to
archive by selecting the check boxes next to the items in the tree view. This
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list is initially populated with the selections that are stored in the users
.archive_state.xml file which is in the user’s $PROWESS_PREFS_DIR
directory which by default is ~/SeisSpace.

The “Clear” button can be used to reset the selections back to an All Off
state so that you can start over and or prevent including things in an archive
that you did not intend to include.

Finalize the selections in the Tree view of the main Navigator display. An
“inventory.xml” file is written to the flow directory. This file is an XML file
that lists the files to be archived and a directory structure on the archive that
it will be mapped to. All of the absolute path names are removed and
replaced by a relative pathname structure. This allows the restore to place
the archived objects into a different directory structure than where they
originated.

Click Next>  to go to the next panel.
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At this point, no additional files have been generated in the flow or output
archive directories.

In this panel you are asked to parameterize the flow that will run to perform
the archive of the selected objects. Click the Help button to get full
documentation for the Archive process. The menu defaults to writing the
archive files to disk. The default disk file system use to write the disk
archive files to is defined by setting the PROMAX_ARCHIVE_HOME
environment variable (documented in the PROWESS_HOME/etc/SSclient
example start script).

Click Next> to go to the next panel.
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In this panel select how you want to run the job either selecting a single
host or send the job to a queue.

Click Next> to go to the next panel.

At this point, no additional files have been generated in the flow or output
archive directories.
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This is the last panel of the wizard.

Click Finish to write the flow and submit the job for execution.

At this point the flow files are written to the flow directory including the
inventory.xml file.

-rw-rw-r--   1 user1 users    10 Feb 28 10:37 DescName
-rw-rw-r--   1 user1 users  3030 Feb 28 10:43 exec.0.log
-rw-rw-r--   1 user1 users 38504 Feb 28 10:43 exec.0.pwflow
-rwxrw-r--   1 user1 users 12733 Feb 28 10:43 exec.0.qsh
-rw-rw-r--   1 user1 users 21304 Feb 28 10:43 inventory.xml
-rw-rw-rw-   1 user1 users   156 Feb 28 10:43 jobs.stat
-rw-rw-r--   1 user1 users 28280 Feb 28 10:43 packet.0.job
-rw-rw-r--   1 user1 users 28280 Feb 28 10:43 packet.job
-rw-rw----   1 user1 users     6 Feb 28 10:43 .promax_pid
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After the flow completes, the following list of files will be in the flow
directory.

-rw-rw-r--   1 user1 users    10 Feb 28 10:37 DescName
-rw-rw-r--   1 user1 users 86381 Feb 28 10:43 exec.0.log
-rw-rw-r--   1 user1 users 38504 Feb 28 10:43 exec.0.pwflow
-rwxrw-r--   1 user1 users 12733 Feb 28 10:43 exec.0.qsh
-rw-rw-r--   1 user1 users 21505 Feb 28 10:43 inventory.xml
-rw-rw-rw-   1 user1 users   156 Feb 28 10:43 jobs.stat
-rw-rw-r--   1 user1 users 28280 Feb 28 10:43 packet.job
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Restore Wizard

The seven steps to running the the Restore wizard are listed in the first
window.

Click Next > to go to step 1 to select the Archive Data Home project.
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In this panel you are asked to select the Archive Data Home project and
also give a descriptive name to the restore flow that will be constructed and
executed by the wizard.

As the text describes, you can choose any project as the archive data home
using the MB3 option, but it must have already been set up as a valid
Archive Data Home with the Archive and Restore areas. The flows will be
written to Lines where the Line name is the current calendar year-month.

The Line name is not under user control, but the flow names are.
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 After running a few archive and restore flows you will see the flows listed
in the tree view as shown below:

Click Next > to go to the next panel.

At this point you will have a new flow in the Archive Data
Home/restore/year-month/date-time directory. In the date-time flow
directory there will be a DescName file only.

The next step is to locate the inventory file for an archive file. When an
archive file is written, the first file within the archive is the inventory file
that was used to create it. The inventory file is the file that was created in
the Archive step when you selected the areas, lines, flows, datasets or
whatever you chose to archive. In the restore wizard you will be asked in
the next step to select what you want to restore from the archive by looking
at a listing of what is on the archive based on the contents of the inventory
file that was used to create it.

There are two places where you may find the original inventory files.

• In the archive protar file

• Stored on disk in a user specified location.

The inventory file is written to the flow directory that was used to create the
archive. You may choose to browse down the
ARCHIVE_DATA_HOME/archive/ directory and locate the inventory file
that you want to use.
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You may have chosen to collect all of your inventory files into a specific
directory of your choosing.

Alternatively, you may elect to extract the inventory file from the archive
file.

The default and most foolproof method is to extract the inventory file from
the archive file. This way you are confident that you have the inventory file
that was actually used to create the archive (the inventory is embedded
within the archive file itself).
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In this panel you are asked to parameterize the flow that will run to perform
the restore of the inventory file. Click the Help button to get full
documentation for the Restore process. The menu defaults to reading the
inventory file from a previously written archive file on disk. The default
disk file system use to retrieve the disk archive files from is defined by
setting the PROMAX_ARCHIVE_HOME environment variable
(documented in the PROWESS_HOME/etc/SSclient example start script).

Click Next> to go to the next panel.

This will start a local job running that will extract the inventory file from
the archive file. You may experience a brief delay while this happens.

At this point if you extracted the inventory file from the archive file you
will have some new files in the restore flow directory. The extraction of the
inventory file required that a job be run to read the archive file and extract
the inventory file. You will see the following list of files in the flow
directory:

-rw-rw-r--   1 user1 users    10 Feb 29 07:50 DescName
-rw-rw-r--   1 user1 users 46028 Feb 29 08:10 exec.0.pwflow
-rw-rw-r--   1 user1 users 21505 Feb 28 10:43 inventory.xml
-rw-rw-r--   1 user1 users 34560 Feb 29 08:10 packet.0.job
-rw-rw-r--   1 user1 users 34560 Feb 29 08:10 packet.job

In this next step you are asked to finalize your selection of what you want
to restore by selecting the check boxes next to the items in the left hand
side tree view. This list is populated with the contents of the inventory file
that was chosen in the last step. You are also presented with a second
selection list on the right side that is your current project listing. This panel
has two steps that need to be completed:

• Select what you want to restore.

• Select where you want the selected items restored.

This example will show how to select a single dataset from an existing
archive and put it back into a different DATA_HOME/Area/Line than it
came from originally.

The main dialog looks as shown below:



Archive and Restore77 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs



Archive and Restore78 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs

First look at the left side where you will select what you want to restore. In
this example choose one dataset to restore.

Click in the box next to the items that you want to restore and it will get the
check mark. Looking up the tree you will see the “-” signs indicating that
part of a list has been chosen, but not the entire list.

The next step is to change the mapping between the original
Data_Home/Area/Line names on the left panel to the destination
Data_Home/Area/Line on the right panel.



Archive and Restore79 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs

Looking at the red text of the data home, area and line directories you will
see text -> text which indicates the current selection of origin to destination
locations. The default is to put the chosen objects back into the same
directory structure from where they originated. If this is the goal then you
are done and don’t need to make any new selections. But there are many
occasions where you will not have the same directory structure when you
want to do the restore. So you have to change the original -> destination
mapping.

• select the data_home level on the left side. All of the available
data_homes in the current environment will show up in the right
panel.

• select the destination data_home from the right panel (as seen below)

You must choose the Data_Home project level from the list on the right.

The mapping in the left pane will update to show the original data home ->
the target data home for the restore operation.

For the Area selection you have a choice to either, do nothing and leave the
name the same, select an existing area or line or create a new one. If you
leave it the same and it does not already exist - it will be created. Similarly,
if you choose the Rename option by double clicking on the entry in the left
side tree view the new area or line will be created by the restore process.
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You can either select an existing area from the Choose Area Destination
view on thr right side with MB1 or click on the name twice in the left hand
tree view button to change the name to something else. The Areas under
the project you have chosen will be shown in blue text identifying them as
selectable objects.:

If you want to select an existing area you can choose one of the Areas in
the project that you selected previously.. The mapping text will update in
the left tree view.

The Rename option allows you to change the name of the target output area
by putting you into an edit mode where you can type in a new name of a
new area to create. Click on the area name twice to enter manual rename
mode, enter the desired text and press Enter.
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Selecting the target LINE name for the restore is the same procedure as for
the AREA selection. Either do not change it, select an existing line, or type
in a new line name. If you leave it the same and it does not already exist - it
will be created. Similarly, if you choose the Rename option the new area or
line will be created by the restore process.

At this point, no additional files have been generated in the flow or output
restore directories.

Click Next > to go to the next panel.

In this panel you are asked to parameterize the flow that will run to perform
the restore of the selected objects. Click on the Help button to get full
documentation for the restore process. The menu defaults to reading the
archive file from disk. The default disk file system use to locate the disk
archive files is defined by setting the PROMAX_ARCHIVE_HOME
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environment variable (documented in the PROWESS_HOME/etc/SSclient
example start script).

Click Next > to go to the next panel.
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In this panel select how you want to run the job either selecting a single
host or send the job to a queue.

Click Next > to go to the next panel.

At this point, no additional files have been generated in the flow or output
archive directories.
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This last panel of the Wizard.

Click Finish to write the flow and submit the job to be run.

At this point the flow files are written to the flow directory including the
restore.xml file.

-rw-rw-r--   1 user1 users    10 Feb 29 07:50 DescName
-rw-rw-r--   1 user1 users    38 Feb 29 10:35 exec.0.log
-rw-rw-r--   1 user1 users 46635 Feb 29 10:35 exec.0.pwflow
-rwxrw-r--   1 user1 users 12733 Feb 29 10:35 exec.0.qsh
-rw-rw-r--   1 user1 users 21505 Feb 28 10:43 inventory.xml
-rw-rw-rw-   1 user1 users   156 Feb 29 10:35 jobs.stat
-rw-rw-r--   1 user1 users 34560 Feb 29 10:35 packet.0.job
-rw-rw-r--   1 user1 users 34560 Feb 29 10:35 packet.job
-rw-rw-r--   1 user1 users  1902 Feb 29 10:35 restore.xml
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After the flow completes, the following list of files will be in the flow
directory:

-rw-rw-r--   1 user1 users    10 Feb 29 07:50 DescName
-rw-rw-r--   1 user1 users  8117 Feb 29 10:35 exec.0.log
-rw-rw-r--   1 user1 users 46635 Feb 29 10:35 exec.0.pwflow
-rwxrw-r--   1 user1 users 12733 Feb 29 10:35 exec.0.qsh
-rw-rw-r--   1 user1 users 21505 Feb 28 10:43 inventory.xml
-rw-rw-rw-   1 user1 users   156 Feb 29 10:35 jobs.stat
-rw-rw-r--   1 user1 users 34560 Feb 29 10:35 packet.job
-rw-rw-r--   1 user1 users  1902 Feb 29 10:35 restore.xml
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Working with the Flow Editor

Multiple Flow Editor Tabs

You may find it useful to open multiple flow editor tabs to help separate
work from one line to another or one processing task to another. To open
multiple flow editor tabs you can use the MB3 option menu from the tab
list area of the Navigator.

You can copy processes from one flow to another on different tabs using
the pulldown copy and paste or the Ctrl-C and Ctrl-V hot keys. There is no
facility to drag and drop between the tab panes.

Tab pane closing behavior when a tab pane becomes empty is controlled as
a preference in the flow editor tab of the preferences dialog. Options are to
Not close, Automatically close, or prompt for a choice.

A special History tab will appear if you select Display Flows from the
History dialog for a dataset.

The tabs are restored when the Navigator is restarted as they were when the
navigator was shut down.

You can also remove tabs that are empty, Rename a tab, or make a selected
tab the default tab which allows you to preselect a tab before you edit a
flow from the navigator table view. For example if you have a table
displayed with multiple flow editor tabs available, you can choose any of
the tabs as the default tab so that flows you select will be put into the
selected tab when they are chosen to be edited,

Opening Flows for editing

From the tree view or table panes you can open a flow into the flow editor
by:

• Double-clicking the flow name from the table list of flows.
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• Single-clicking the flow name from the tree view list (this is the
default setting that preference in the Navigator preferences). (Single-
click is not an option from the table)

• MB3 > Open.

• Using the Open File Icon.

• Using the File > Open pulldown menus.

If you use the MB3--> Navigate option from the tree view,  the table view
will show the "instances" of the flow. You can open older versions. The
instance labeled "-1" is the packet file that will be read by the conventional
ProMAX® user interface or the last version saved by the ProMAX® user
interface.

You can set the flow editor appearance and operational preferences with the
Flow Editor tab of the preferences dialog box.

There are two ways of viewing flows: the Individual Dialog box mode (the
default) and the Scrollable window mode.

Individual Dialog Box
Scrollable window

Toggle option
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You can switch back and forth using the Toggle Parameter List Icon.

You can also choose which mode to use as your default from the Edit >
Preferences dialog box by checking or unchecking the "Use Dialogs
instead of scrolled list of parameters for all processes" option.

Note: When you select a flow for editing from the tree or the table listing,
you will always get the most recent menu (or highest numbered instance).
You do not have to select the highest numbered instance from the instance
list.

If you want a specific instance, an older version for example,  select the
desired instance from the instance list in the table pane.

If you have edited the flow in the ProMAX® user interface, you will need
to go to the instance list and choose the -1th instance to get the most recent
version of the packet file.

Saving flows

Every time a flow is edited and saved or submitted, the flow is saved twice:
once as an XML file (exec.#.pwflow) and again as the binary file;
packet.job.

New instances are generated when a flow is submitted for execution or
edited and saved.

An instance saves all components of the flow including the job file and the
printout.

Adding Processes to a flow

There are many ways to add processes to a flow:

• Drag and Drop a process into the flow from the processes list. You
can add (or remove) the processes list from the flow editor tab using

the "show or hide processes list" icon.

• Click MB1 on a process and it will be added after the process that is
currently selected in the flow’s list of processes. Note: this is con-
trolled by a user preference.

• Use the quick search option. This option is enabled by typing in the
flow window in the flow editor. Note: you do not have to position the
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mouse in the text box. Keystrokes will be reflected in the text box of
the currently active flow.

• Drag and Drop a process from another flow that is open in the editor.

Flows can be built very rapidly using the quick search capability and the
arrow and Enter keys to select the processes.

There is a subtle functionality difference here depending on where
keyboard focus is when you use the up and down arrow keys. If focus is
given to the small search window at the top of the flow edit window by
clicking in it with the mouse, the up and down arrow keys will repeat the
last search. This is useful if you are selecting the same process multiple
times or if the processes you are looking for all have some characters in
common. The more general use here would be just give keyboard focus to
the main edit window and just start typing. The up and down arrows and
enter keys can still be used to find and select the process. After the process
is selected you can then use the up and down arrow keys to select the next
process you want to add new processes after. This is useful while you are
building a flow and realize that you have forgotten to add in a process
earlier in the flow.

The first entry in the returned list is automatically highlighted so that as
you get better at narrowing down the search characters you can just hit
enter to select the single (or first) process in the list.

The Processes List

There are a few functional icons at the top of the processes list:

From Left to Right:

when you Use arrows
and Enter
or the
mouse to
select the
process

type with
the focus
on a flow,
the
characters
will show
here and
activate the
search
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• a/z : Select to alphabetically sort the list of processes. The default dis-
plays processes in the same manner as the conventional ProMAX®
user interface. That is, processes are shown in the exact order that
they are listed in the Processes list. Sorting alphabetically sorts the
categories alphabetically as well as the processes in the category.

• The double + icon will expand the list to show all processes in all cat-
egories

• The single + icon will expand/compress to show only the major pro-
cess categories

Alphabetic
Listing
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• The refresh icon can be used to refresh the procsses list with a full
reread from disk for the specified product.

• The X icon will close the processes list panel.

The Processes List (Development Status Processes)

There are two major types of SeisSpace tools: those that have been deemed
ready to use in production and those that are in a development status.
Production tools are supported, development status tools are not, but we
would still appreciate feedback on these toools so that we can eventually
get them to production/supported status.

To view the list of development status tools you can toggle them on and off
using the Product > Show non production Tools pulldown from the top of
the Navigator screen, or the icons on top of the processes lists.

With the toggle selected, the Development status tools will be available in
the Processes list and the quick search utility in the flow builder. When
active, the icons will be highlight in a blue background and the pulldown
menu will be "checked". The first icon on the processes list icon bar is for
the user development processes and the one on the right is for the base
system development processes delivered by Landmark.
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The Development status tools will be annotated with the D overlay on the
Green Diamond icon.
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The Options Menu for Processes in a Flow

There is an options menu available for all process in a flow.

This options menu can be enabled using either MB3 on the process or
CTRL-MB3 on the process depending on your preference setting. In the
flow editor tab of the preferences dialog there is an option:

If this option is checked "ON" then you can enable the options menu using
CTRL-MB3. While editing flows, the most probable reasons for needing
this options list is to have access the online help documentation or to edit
comments.
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The "Versions" option will be discussed in the development environment
section of the documentation.
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The Options Menus in the white spaces in the Flow Editor Tab

There are two additional options menu available in the flow editor:

• one in the white space inside a flow,
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• and another in the white space outside of all the open flows.
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The Options Menus on dataset names in IO processes

For any process that allows you to select datasets you can MB3 on the
dataset in the menu to get a list of options. The list will vary depending on
what type of dataset it is.

Online help for the Processes

While building flows or parameterizing processes in a flow you may want
access to some help to describe the process and guide you through
parameters. One way to get the help files is to press the F1 key after
selecting the process with MB1 in the flow editor. If a parameter selection
dialog is open for a process, F1 will open the help document for the process
For access to the complete help document for a process in the processes list
you can use the MB3 > Help on Process option:
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If a process is in a flow you can get help using the MB3 (or CTRL-MB3) >
Help on Process option. You can select the process with MB1 and then
press the F1 key. The Edit > Help on Process pulldown menu is another
option that can be used to get help on a selected process.

ProMAX® process Icons and hybrid parallelization

The list of ProMAX® modules that can be run in a Hybrid environment is a
subset of the entire processes list. For example, no ProMAX® process that
writes trace data or writes attribute data to the database can be run in a
multi-joblet hybrid flow. There are other exceptions. The processes that
have been tested and have shown to produce correct output from a multi-
node multi-joblet distributed hybrid job have been annotated with a

"parallel ProMAX®" icon in the processes list and in the flow editor. .

Some ProMAX® processes are annotated with a "ProMAX® x" icon
indicating that they are illegal in a Hybrid environment. You will not be
able to submit these jobs.

Other ProMAX® processes are annotated with a "ProMAX® yield" icon

 indicating that they can only be run in a single joblet hybrid job.



Working with the Flow Editor100 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

Hybrid flows are also expanded in the flow editor with warnings about the
ProMAX® processes in them.

If you try to execute a hybrid flow that has illegal processes in it you will
receive the following dialog box:

illegal

single joblet
only
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Adding Comments to Processes

You can add comments to processes in flows using ----- Add Flow
Comment ----- or using the comment editor. This is applicable for both
ProMAX® or SeisSpace® processes. Enter your comments in the dialog
box. You can also edit or delete comments.

User Defined Header Management

The user defined headers list is kept in a file called .user_headers which can
be stored at any or all of the DATA_HOME directory level, the AREA
directory level, or the LINE directory level. The Header list will be the
concatenation of all of the user headers found in the files at all three levels
if they exist. The administrator can control which level can be used by the
users and where the default location will be. This procedure is outlined in
the SeisSpace System Administration Document. Any tool that accesses
the "SeisSpace/ProMAX® Headers" selection dialog can add, delete, or
relocated headers to this different lists. The user defined headers are listed
together with the standard headers for selection.

Note: Not all tools that add headers use this dialog. There are cases where
user defined headers will show up as "transient" values in the list.
ProMAX® Trace Header Math does not access the header selector so new
attributes generated by this tool will not be added automatically to the
.user_headers file, but they will show up in the header selector as long as
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the Intelligent Parameterization is active or the init phase has been run in
the Flow Builder.

A simple example of how this works would be to use the ProMAX®
Database/Header Transfer tool.

When you add the new header in the header selector it is added to a
..user_headers file at the selected directory level.The header is added to the

list when the Create and Choose button is clicked.

Note: depending on the setting in the prowess.properties file you may or
may not have the choice of Data Home, Area, or Line for saving the header
entry. If the option if grayed out and inactive, the administrator has elected
to not give users this privilege.
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When you choose the header entry dialog again you will be presented with
the SeisSpace®/ProMAX® Headers dialog where you can choose existing
headers or add new ones.

The user defined headers that have already been added appear in the
BOLD/Italic text.

The headers that are in italicized blue are "transient" headers that are added
by processes in the open flows. These are temporary headers that are only
in memory in the available data contexts and do not exist in the
.user_headers files. All transient headers from all open flows will be shown
in the list and are available for selection if desired. You may also use the
MB3 - option menu to save these permanently. Other option in the MB3



Working with the Flow Editor104 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

options menu include the ability to move a header from one .user_header
file to another, or delete entries in the .user_headers files.

The file that stores the information is the .user_headers file and is an
editable XML file. If you want to change the default description of the user
defined header you can edit this file manually.

Data Context and Header Catalog at any point in a flow

As you are working on a flow you may want to know what the header
catalog and/or the data context is at any point in the flow. For SeisSpace®
flows (as long as Intelligent Parameterization is on) you can always get the
context and header list at any point in the flow. For ProMAX® or Hybrid
flows you need to run the Intelligent Paramertization (Init Phase) manually

by clicking on the "init phase" icon. After running the init phase, the
header catalog and data context are available.
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In this example, the ProMAX® trace header math is adding header
"pmthm1". If you look at the header list after the Trace Header Math using

the Inline Show Header Catalog Icon: you will see this header in the
list in a blue/italic font. This means that it is a non-standard header but is
not cataloged in the .user_headers file. You can save it to the .user_headers
file by MB3-Store on the header from the list.

MB3-Remove can be used to remove headers from the .user_headers file.
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If you then click on the Database/Header Transfer process you will see that
the "pmthm1" header is not in the header catalog at that point in the flow.

Similar to the header catalog you can interrogate the data context at any

point in the flow if you click on the context icon . The context

PMTHM1 missing
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summary is in a separate dialog and you can ask for the header list from
this dialog if so desired.

Setting site and user defaults for SeisSpace® and ProMAX® tool
menus

There are cases where some sites want to set the defaults for parameters in
processes that are more appropriate than the defaults set by Landmark.
Typical examples include setting the data output tools to use secondary
storage or to use full 32-bit floating point storage. In the past, ProMAX®
modules have been user configurable after the installation by manually
editing the text menu files. SeisSpace tools were not user configurable
except for a couple of default settings in the prowess.properties file.

There are now two levels of user configurable defaults that are available in
the flow builder: Site level defaults that are managed by the administrative
user and User level defaults that are managed by each individual user. Both
levels are stored as flows where the general methodology is simply to build
a flow that contains the processes of interest, setting the default values and
marking the parameters to be used as overriding defaults.

The Default flows are stored in different locations by default:

The Site level (or administrative) default flow is stored in a flow directory
$PROWESS_ETC_HOME/defaultdatahom/defaultarea/defaultline/site or
$PROWESS_HOME/etc/defaultdatahom/defaultarea/defaultline/site.

The user default flow is stored in a flow directory:
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$HOME/SeisSpace/defaultdatahom/defaultarea/defaultline/user or
$PROWESS_PREFS_DIR/defaultdatahome/defaultarea/defaultline/user.

The administrator may want to use a setting in the PROWESS_HOME/etc
(or PROWESS_ETC_HOME)  /prowess.properties file for where the user
default flows are being stored. The stanza can be set to point the user
defaults to the same general directory as the site level defaults for example:

# You can define a common location under which to create a hierarchy
for
# user parameter defaulting flows. For example, you can set this to
# the value of $PROWESS_HOME/etc or $PROWESS_ETC_HOME
if this variable is set.
# The default is $HOME/SeisSpace or $PROWESS_PREFS_DIR if
this variable is set.
# the directory structure under this is
.../defaultdatahom/defaultarea/defaultline
#com.lgc.prodesk.navigator.userDefaultsDir=$PROWESS_ETC_HO
ME

If the above property is set to the default value, the user default flows are
named $PROWESS_ETC_HOME/defaultdatahome/defaultarea/
defaultline/userusername
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To build the flow that is used solely to set parameter defaults you would use
the Edit > Administration > Edit Parameter Defaults pulldown menu.

If you are currently set as the administrative user, the Global Defaults
option will be enabled.

When you select either the Global (or Site) default flow or the User default
flow, the flow will be added to a Default Flows tab in the flow builder. You
will not be able to add any other flows to this tab or submit any flows for
execution from this tab.
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To set a parameter default, add the process to the flow, set the parameter
value and check the box next to the parameter in the menu dialog.
Checking the box is the indicator to use the value as the default.

You can add as many processes to the flow as you like and set as many
parameter defaults as are required. There are some parameter types where
defaulting has been disabled such as the dataset name selector and some
informational parameters.

User defaults override the Site level defaults.

Both ProMAX® and SeisSpace® processes can be defaulted in this
manner.

Parameter defaults will not be used for processes in a Disabled state in the
flows.
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Object Grouping and Group Copying

Object Grouping was implemented to help support the data explosion of
flows, datasets and tables for a project by grouping like named objects into
a sub-view to shorten the lists in the tree and table views of the navigator.

Object grouping allows you to apply a constant prefix to like named objects
and display them in a sub-list on their own. This may help reduce a long list
of flows or datasets to a more manageable list with sub-lists.

For example, you may have several different versions of CDP gather
datasets. You may elect to "group" them together so that in the main
datasets list you see "cdps-", but you can further expand that list into the
table to see all of the cdps-* datasets.

NOTE the actual dataset name of the file on disk. cdps-@xxxxxxxxx. The
@ symbol is the designator for separating a common prefix from a more
descriptive suffix. Also note that only the suffix is used as the descriptive
name in the navigator.

For datasets you can control the groupings in either a manual dataset create
mode or in a flow-replication auto create mode by including a common
"prefix@"  before the descriptive name.

The same methodology can be applied to flows and tables.
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Remember that flow replication already does this replica compression so
you do not see all of the individual replicas in the flows list.

Below is a picture showing a group of similarly named flows that are
grouped into the 20* group. This example also shows that the group can be
expanded in the tree view if so desired.
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Grouping and Un-Grouping existing objects

If you have a series of existing datasets that you want to group you can
choose them all in the table view and use the MB3 - Group option
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You will be presented with a dialog asking for the group name with an
option to remove the group name from the existing names.

This will result in the creation of the "stack" group with the dataset
descriptive names having the "stack" text removed and a rename of the file
directories to stack@*

Objects that belong to a group can be un-grouped by a similar procedure of
selecting the objects in a group that you want to un-group, choose the
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Group option from the MB3 options menu and then un-select the "Group"
option. The un-grouping options will then be enabled:

Adding new objects to a group

When adding new datasets, the dialog prompts you to choose or enter a
new group if you check the Group check box
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Double click in the group entry box to get a list of the existing groups or
type in a new group prefix name.

Then add the descriptive part of the file name

This will result in a dataset being added to the "stack" group with a file
name on disk of stack@-brute and a descriptive name of "-brute"

Grouping and Un-grouping of existing flows and tables follows the exact
same procedures as does the generation of new flows and tables.
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The Flow Viewer

The Flow Viewer can be used as an alternative to loading the flow into the
editor to see what is in the flow. The Flow Viewer is started by using the

icon . There are four different views available in the Flow Viewer:

• Flow- A text "pretty print" of the processes and parameters
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• Flow HTML - A formatted HTML printout.
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• XML - Shows the actual XML contents of the pwflow file for the
flow.



Working with the Flow Editor120 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

• XML tree - generally only used by developers for debugging. This is
not very useful to users.
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Printing a flow to HTML

You can print the flow to a HTML file and view it in a browser. If you select

the browser icon  when working with a flow or a flow list. The
browser that is used is controlled by the
PROMAX_HOME/port/bin/PromaxFlowPrinter script and defaults to
Netscape for Operating systems other than Linux. For Linux it defaults to
Mozilla.

The HTML file is saved in the flow directory as the packet.html file.
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Submitting a Job for Execution

You can submit jobs for execution from

• the tree view of a list of Flows,

• the table view of a list of Flows,

• the Flow Editor tab, and

• the Replica Job Table (when working with replicated flows).

In all cases, the following three job submit icons provide a variety of job
submit options:

There are three fundamental methods available to submit jobs:

• direct submit on the machine where the navigator is running as a sin-
gle joblet job

• a directed submit to either a user specified host list or to a Queue for
either single joblet, multi joblet, or PVM jobs, and

• resubmit as the job was submitted previously.

Note: there are two stanzas in the SeisSpace/etc/prowess.properties file that
you may want to set for your specific Q behavior. If you are using the
delivered capabilities without any additional user modified q scripts, you
should not change the settings for these values in the prowess.properties
file.

# Whether or not show the joblet specification (number of nodes, number of
# execs per node, number of joblets) in the Submit dialog; the default
# is to show it. If you customize your queue menu and submit scripts in such
# a way that you take responsibility for how to obtain the number of joblets,
# you may want to hide these parameters in the Submit dialog.
com.lgc.prodesk.jobviewer.showJobletsSpec=true

# Indicates whether the submit dialog will automatically load the default
# submit parameters  or the resubmit parameters when it is displayed.
com.lgc.prodesk.jobviewer.autoload=true

Direct Submit
Queued and
custom node
list submit

Resubmit



Working with the Flow Editor123 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

Direct Submit

This option directly submits a job as a single node - single joblet job. The
job will run on the machine where the Navigator/Flow Builder is running.

Queue and custom node list submit

This option allows you to customize the submit parameters of a job or set
of jobs and also allows you to set up a job submission default. A common
use would be to set up a default queue for most jobs.

General usage would be to parameterize the default Queued submit and
then save this configuration and optionally set it as the DEFAULT.

A Ctrl-MB1 combination on this icon will submit the selected job(s) sing
the saved DEFAULT job submit configuration. If you want to do something
else, then you can click MB1 on this icon and the submit user interface will
present itself and you can choose the submit parameters as you desire.

The main job submission user interface has three major options: Hosts,
Cluster, and Queue.

All of these options allow you to reorder selected jobs for submission if
you have selected multiple jobs from the table list in the Navigator. That is,
you can put them in the Queue in a different order than they were selected.

Select the "reorder" icon to enable this feature. First Select the flow
(or flows) that you want to move with MB1 and Ctrl or Shift MB1
combinations and then drag the selection to the location where you want to
drop them. They will be dropped below the dark bold line. To move a
single flow to first select the flow with a click and release with MB1 and
then hold and drag with MB1.

The joblet count (or parallelization) part of the user interface is the same
for all of the options. See each individual section for details.

Submit (button)

This button will submit the job(s) with the selected submit configuration.

Cancel (button)

This will cancel the job submit operation.

Save and Load (buttons)

This option will allow you to save different job submit configuration as
defaults which can then be accessed later. The DEFAULT saved
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configuration is accessed when using the Ctrl-MB1 option on the job
submit icon from the flow editor or the table view of the Navigator.

You may elect to save multiple submission variations for easy access later.
There is the one main DEFAULT configuration that is what is recalled if
you use the Ctrl-MB1 option on the second job submit icon. You can SAVE
additional submit configurations and then reload them using the LOAD
button in the submit dialog box.

The "binocular" icon can be toggle from blue to gray background. When in
a blue background, as you select the different configuration choices in the
list, the Submit dialog will update with the parameters for inspection before
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you actually choose one. When in light blue/shaded background the Submit
dialog will not update as you click on the different choices in the list.

When set to User mode - the different job submit configurations are store in
the users user_prefs directory.

When set to Shared mode - the different job submit configurations are
stored in the "logs" directory. General users may not have permission to
write to this directory.

Hosts option

The host option will present a list of the machines that have been added to
the hosts list.

You can select multiple hosts on which to run the job in parallel. Select
multiple nodes with Ctrl-MB1 to select individual nodes from the list or
Shift-MB1 to select a range of nodes.
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Number of nodes

This parameter is automatically filled in based on the number of hosts that
were selected from the list.

Execs per node

Specify the number of execs per node to use to run the job.

Cluster option

You can select from a list of predefined cluster definitions. These cluster
aliases are defined in the Administrator Tool.

This option is not available for simple single exec ProMAX® jobs or any
combination of jobs that include single exec ProMAX® jobs.

Number of nodes

The "number of nodes" option is not user configurable in this mode. The
number of nodes will be set to the number of hosts that make up the cluster
definition for combinations of SeisSpace®, Hybrid or ProMAX® Parallel
Begin/ Parallel End jobs.
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Execs per node

Specify the number of execs per node to use to run the job.

Queue option

For all types of jobs, select the Queue for submission. The contents of the
central box may vary depending on which queue system you are using and
how they have been customized by your administrators.

Queue server:

Select the Queue server from the available list. This action reads the
$PROMAX_HOME/etc/qconfig or $PROMAX_ETC_HOME/qconfig file
and presents the list of servers found on the "machine" lines in the qconfig
file.

Queue name:

This presents a list of the known queues for the selected server. The list of
Queues can be initiated by clicking on the "refresh" icon in the submit user
interface. This action reads the $PROMAX_HOME/etc/qconfig or
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$PROMAX_ETC_HOME/qconfig file and presents the list of queues
found in that file for the specified server.

Queue Node Properties

You can specify a property to add to the queue directive line that is built for
submitting the jobs. You will need to know the options here, consult your
administrator for the list of properties at your site.

Overrides the default ppn (processes per node)

This does not control the number of processors for ProMAX® jobs or
SeisSpace® jobs. This is used only to specify the ppn specification on the
QSUB directives to tell PBS/Torque how many processors (or mom units)
to allocate for this job. With this set to 1, you will most likely get multiple
ProMAX® jobs per node. With this set to the number or cpus as configured
in the server_priv/nodes file you will most likely get 1 ProMAX® job per
node. Do not specify a number higher than the actual number of processors
per node that you have. (Hyperthreading may allow you to specify more
nodes as long as the server_priv/nodes file in the PBS / Torque
configuration also reflects the higher number of virtual nodes). The default
ppn value (0) is reset to the number of joblets per node (execs/node *
joblets/exec). If you are working in a pure ProMAX® environment and you
want to restrict the number of jobs per node to 1. Then you can use this
override to set the ppn to the maximum number of cpus per node for each
job.

Main Dialog

number of nodes

The "number of nodes" option is user configurable in this mode. If the job
is parallelizable, the user parameters will be honored, If the job or some of
the jobs in a group selected from the table are not parallelizable, those jobs
will be "dumbed-down" to execute one node - one joblet.

For multi-node ProMAX® Parallel Begin/ Parallel End jobs, leave the host
list blank in Parallel Begin. The host list will be filled with the list of nodes
that was returned by the Q system when the job was released.

execs per node

Specify the number of execs per node to use to run the job. If the job or
some of the jobs in a group selected from the table are not parallelizable,
those jobs will be "dumbed-down" to execute one node - one joblet.
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Resubmit

Use this option if you want to resubmit a job exactly the same what it was
submitted previously. This icon also has CTRL-MB1 and MB1 options.
This is handy if you have selected a specific list of nodes for a SeisSpace®
job and the first attempt fails for some reason. You can fix the problem in
the flow editor and CTRL-MB1 click this icon to resubmit with the
previously chosen submit parameters.

MB1 displays the job submit dialog box populated with the last submit
parameters.

CTRL-MB1 resubmits using the same parameters as the last submit,
bypassing the job submit dialog box.

Reset

Use this option to restore the original parameters.

General Rules - for job submission

The rules surrounding job submit parameterization can be quite complex
especially when you select multiple jobs of multiple types from the table
list of flow. The general rules of parallelization can be summarized as
follows:

ProMAX® single exec jobs - can run on one CPU of one node. Number of
nodes and execs per node are forced to be 1.

ProMAX® Parallel Begin/End PVM jobs can be run on multiple nodes,
with multiple execs per node.

Hybrid jobs can be run on multiple nodes with multiple execs per node.

SeisSpace® jobs can be run on multiple nodes with multiple execs per
node.

Hybrid jobs are screened to determine if they can be processed in parallel.
That is, there are many ProMAX® processes and a couple of SeisSpace®
processes that can only be run in a single joblet Hybrid flow. The Job
submit protocals will treat a Hybrid flow with non-parallelizable
ProMAX® processes in it as if it were a single exec ProMAX® job. That
is, it can only be submitted to a single node with one joblet.

You will always be allowed to choose multiple nodes and multiple execs
per node. If the job you are submitting or any of a group of jobs selected
from the table are not parallelizable, those jobs will be downgraded in the
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submit process to run on a single joblet on a single node. You will be
notified as to which jobs were downgraded in an information dialog box.

For multi-node ProMAX® Parallel Begin/ Parallel End jobs, leave the host
list blank in Parallel Begin. The host list will be filled with the list of nodes
that you selected with additional instances for the number of execs per
node that was selected.
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Purging Flows

The SeisSpace® Flow Builder will keep an user configurable number of
copies of flow files and printouts from previous executions.

You can purge (delete) the oldest instances of the flow by using the

Edit >Purge pulldown menu or the Purge Icon.

For example, a flow with 25 instances can be purged down to only
instances 21 through 25 using the default of five. The -1th instance is
retained as the packet.job. The number of instances remaining after a purge
can be configured in the preferences dialog.

You can also select multiple flows or even complete subprojects to apply
the purge option.

Note: Purging cannot be undone.

Restore a flow to its original state

If you have a flow in the editor that has been changed but you want to revert
it back to its original state without closing it and not saving the changes and
then re-opening it, you can use the "Revert Flow" icon

You can select File > Revert Flow or use the "Revert Flow"  Icon. .

Overlaying menus

With each new release, the parameters in some processes change. A
feedback dialog box will tell you which parameters are new or have been
removed from a process. You can update ProMAX® processes in an
existing flow using the overlay option. You can also select multiple
processes and overlay an entire flow in a single operation.

You can select Edit > Overlay ProMAX menu(s), use the Overlay

ProMAX® Menu(s) Icon. , or use SHFT-MB2 as you have used in
the past with the ProMAX® user interface.

Note: SeisSpace® processes do not need updating in this manner.

Dataset Processing History

ProMAX® datasets use the original ProMAX® history viewer.
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JavaSeis dataset history is stored with the dataset in the History.xml file in
the primary storage (project) directory.

In both cases you can see the history using the MB3-History option from
the options menu.

The ProMAX® history viewer is documented in the ProMAX®
documentation.
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The JavaSeis history viewer shows the text "pretty print" concatenation of
the flows and processes and parameters that were used to create the dataset.

You may choose to rebuild the flows from the history using the "Display
Flows" button. These flows will be added to the History tab in the flow
editor pane and added to the list of flows for the project.

The ProMAX® History Viewer button will be active for ProMAX®
datasets that were written using ProMAX® Disk Data Output from a Pure
ProMAX® Flow.
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Area, Line, Flow, Table, Dataset name restrictions

ProMAX® and SeisSpace® projects, subprojects, flows, tables and dataset
names can have spaces, as well as mixed case, but are limited to 30
characters. Actual UNIX paths are all lower case, and where all of the
blanks and certain other characters are removed.

ProMAX® database object naming has the same restrictions as the
conventional ProMAX® system.

The length of the name can be controlled by setting the value of the
parameter length entry in the PROWESS_HOME/etc/prowess.properties
file. The default is set to enforce the 30 character limit for backwards
compatibility with the ProMAX® user interface. The alternative is to have
unlimited length. For this property change to take effect you will need to
exit from the Client, edit the prowess.properties file and then restart the
client.

Adding a new Projects and Subprojects (AREAs and LINEs)

You can add a new Project (or AREA) by placing the cursor on the project
in the tree view and using the MB3--> New Project option.

Enter the new Project name and select the coordinate system for this
project. Landmark recommends selecting UNKOWN for the coordinate
system at this time.

The procedure for adding Subprojects (or lines) is identical.

Properties for existing ProMAX® Projects

When you set up a "Data_Home" in the Admin tool you were asked to
enter information about the project, such as the path to the Data Home
directory and required environment variables. These variables include the
path to a config_file and a scratch directory. You can review to the list of
system environment variables and append environment variables for
different users by using the Properties dialog. Select MB3 > Properties to
display the dialog. This dialog may or may not be editable depending on
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whether this is a shared or a private project and if you are logged in as an
administrator or not.

Configuration for a ProMAX® development environment

In a standard development environment, a user’s directory mirrors the path
to the production directory. For example, if the ProMAX® software is
installed in the directory /apps/vendors/landmark/ProMAX then the
developer should have ~/apps/vendors/landmark/ProMAX in the home
directory.This mirror directory is usually created by the
$PROMAX_HOME/port/bin/ Makeadvance script.

Users would set the MY_PROMAX_HOME environment variable in the
SSclient start script to access user menus, executables and documentation
files.

User Processes List

The ProMAX® development environment is slightly different in the
SeisSpace® software relative to the ProMAX® software. The main
difference is how the Processes list is handled. In the legacy ProMAX®
development environment, the developer must maintain a Processes list
that is the combination of the production Processes list delivered with the
release and the developer’s Processes list. In the SeisSpace® software, the
developer need only maintain the list of developer processes. The
SeisSpace® software appends the processes found in the developer’s
processes list to the production list under a new folder called the
concatenation of the text User ProMAX xx -- and the exact name of the
processes file that it found and is displaying the contents of. You can
specify multiple development environments to enable access to processes
under development by a number of different users

This is enabled by setting an environment variable MY_PROMAX_HOME
in your SSclient start up script to a multi-pathed list of development
directories, where the entries are separated by a " : ". Each colon separated
entry will be a separate folder at the top of the processes list.

MY_PROMAX_HOME=/home/JOE/promax:/home/MARY/promax

JOE/promax/port/menu/promax3d/ProcessesPM

MARY/promax/port/menu/promax3d/ProcessesPM
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As a general rule, make sure that multiple developers do not use the same
names for different processes. For example make sure that Joe does not
have a process A that does scaling and Mary has a process A that does
decon.

Given a multi-pathed MY_PROMAX_HOME as shown above and where
promax(xxx) = promax3d for example:

Search order for Processes List

All Processes lists found in all of the directory entries in
MY_PROMAX_HOME plus the installation will be presented

/home/JOE/promax/port/menu/promax(xxx)/ProcessesPM
/home/JOE/promax/port/menu/promax(xxx)Processes

and

/home/MARY/promax/port/menu/promax(xxx)/ProcessesPM
/home/MARY/promax/port/menu/promax(xxx)Processes

and

$PROMAX_HOME/port/menu/promax(xxx)/ProcessesPM

and

$PROWESS_HOME/etc/flowbuilder/PROWESS.xml

Search order for menus

If a valid absolute path is specified in the Processes list, it will be used,
Otherwise, the system will search for an appropriately named menu in the
following order:

/home/JOE/promax/port/menu/promax(xxx)

then

/home/MARY/promax/port/menu/promax(xxx)

then

$PROMAX_HOME/port/menu/promax(xxx)
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Search order for ProMAX® executables

/home/JOE/promax/sys/exe

then
/home/MARY/promax/sys/exe

then
$PROMAX_SYS_EXE_HOME first path
$PROMAX_SYS_EXE_HOME second path etc...

then
$PROMAX_HOME/sys/exe

Search order for ProMAX® libraries

/home/JOE/promax/sys/lib/syslibs
/home/JOE/promax/sys/lib

then the second path in MY_PROMAX_HOME
/home/MARY/promax/sys/lib/syslibs
/home/MARY/promax/sys/lib

then the SeisSpace® and ProMAX® installations
$PROWESS_HOME/sys/linux(64)/lib
$PROMAX_HOME/sys/linux(64)/lib
$PROMAX_HOME/jre/lib

then the base system library directories
/lib
/usr/lib
/usr/local/lib
/syslibs

Search order for documentation.

/home/JOE/promax/port/help/promax/toolname.pdf

then
/home/MARY/promax/port/help/promax/toolname.pdf

then
$PROMAX_HOME/port/help/promax/toolname.pdf

Help files for user developed modules may be prepared as pdf, html, text,
or FrameMaker files with extensions of pdf, html, help, and lok
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respectively. The $PROMAX_HOME/port/bin/PromaxHelp script is called
to determine which application is started for the various different types of
help files.

Configuration for a SeisSpace development environment

In a standard development environment, a user’s directory mirrors the path
to the production directory. For example, if SeisSpace® is installed in the
directory /apps/vendors/landmark/SeisSpace then the developer should
have ~/apps/vendors/landmark/prowess in the home directory.NOTE that
the last directory is "prowess" and not "SeisSpace". this is different from
the standard ProMAX® development environment. Users would set the
MY_PROWESS_HOME environement variable in the SSclient start script
to access user tools and documentation files.

User Processes List

In the SeisSpace® software, the developer need only maintain the list of
developer processes. The SeisSpace® software appends the processes
found in the developer’s processes list to the production list under a new
folder called the concatenation of the text User SeisSpace --  xx and the
exact name of the processes file that it found and is displaying the contents
of. You can specify multiple development environments to enable access to
processes under development by a number of different users

This is enabled by setting an environment variable
MY_PROWESS_HOME in your SSclient start up script to a multi-pathed



Working with the Flow Editor139 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

list of development directories, where the entries are separated by a " : ".
Each colon separated entry will be a separate folder at the top of the
processes list.

MY_PROWESS_HOME=/home/JOE/prowess:/home/MARY/prowess

As a general rule, make sure that multiple developers do not use the same
names for different processes. For example make sure that Joe does not
have a process A that does scaling and Mary has a process A that does
decon.

Given a multi-pathed MY_PROWESS_HOME as shown above:

Search order for Processes List

All Processes lists found in all of the directory entries in
MY_PROWESS_HOME plus the installation will be presented

/home/JOE/prowess/etc/flowbuilder/PROWESS.xml

and

/home/MARY/prowess/etc/flowbuilder/PROWESS.xml

and

$PROWESS_HOME/etc/flowbuilder/PROWESS.xml

Search order for menus

The system will search for an appropriately named menu in the following
order:

/home/JOE/prowess

then

/home/MARY/prowess

then

$PROWESS_HOME

Search order for executables and libraries

/home/JOE/prowess

then
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/home/MARY/prowes

then
$PROWESS_HOME

Search order for documentation.

/home/JOE/prowess/port/help/seisspace/toolname.pdf

then
/home/MARY/prowess/port/help/seisspace/toolname.pdf

then
$PROMAX_HOME/port/help/seisspace/toolname.pdf

Help files for user-developed modules may be prepared as pdf, html, text,
or FrameMaker files with extensions of pdf, html, help, and lok
respectively. The $PROMAX_HOME/port/bin/PromaxHelp script is called
to determine which application is started for the various different types of
help files. All help files delivered by Landmark are under the
$PROMAX_HOME/port/help directory.

Using user-defined icons for user-defined processes

You may find it useful to annotate the processes from different
MY_PROMAX_HOME’s and MY_PROWESS_HOME’s with different
icons so that you can tell which "library" of tools a particular tool came
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from. The picture belows shows a variety of different source directories
with different icons:

To achieve this you can add your user defined icon to your user defined
MY_PROMAX_HOME and MY_PROWESS_HOME directories.

For the ProMAX® system, add a file called user_tool.png  (or gif) to the
directory MY_PROMAX_HOME/port/menu/promax(xx)/user_tool.png.

For SeisSpace, add a file caled user_tool.png (or gif) to the directory
MY_PROWESS_HOME/etc/flowbuilder.

These icons should be 8x8 or a maximum of 10x10 and they will work
better if they are "pastel" or low intensity colors so that the D
(development) flag can appear on top of them if they are Development of
Alpha testing status user tools.
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You will need to restart the Navigator after adding or replacing these icons
to see the changes.

Refreshing the processes lists

The PROWESS.xml lists are cached to memory in the Flow Builder as they
are read and used. You can refresh the cache by forcing a reread of the file
by using MB3 > Refresh on the top level folder in the tree view of the
processes list or click on the refresh icon on the icon bar of the processes
list.
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SeisSpace® 3D Prestack Time Migration
Workflows

The following is the supported 3D Prestack Time Migration workflow:

The SS- prefix indicates that these are SeisSpace® processes that will
appear green in the flow builder.

Build a SeisSpace® job to create gathers on velocity lines.

SS-JavaSeis Input --> SS-Specify CDP Bin Grid --> SS-JavaSeis
Create (PSTM gathers)

SS-JavaSeis Input --> SS-Specify CDP Bin Grid --> SS-3D Prestack
Kirchhoff Time Migration --> SS-JavaSeis Output (PSTM gathers)

Build jobs to perform NMO or RMO velocity analysis and generate a QC
stack.

JavaSeis Input --> NMO (inverse) --> Supergather Select --> Disk
Data Output

Disk Data Input --> PreCompute --> Disk Data Output

Disk Data Input --> Velocity Analysis with PD connection to VVE

VVE with PD connection to VA

JavaSeis Input --> NMO (inverse) --> NMO (forward) --> Stack3D -->
JavaSeis Output

Run the full project PSTM to gathers jobs using the updated velocity fields
from the NMO or RMO analysis step

JavaSeis Input --> SS-Specify CDP Bin Grid --> JavaSeis Create

JavaSeis Input --> SS-Specify CDP Bin Grid --> SS-3D Prestack
Kirchhoff Time Migration --> JavaSeis Output

JavaSeis Input --> Stack3D --> Disk Data Output
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Replicating Flows

Supported functionality

The following functionality for flow replication is supported:

• building template flows

• selecting parameters that change from one replica to another (limited
to numeric values, strings and sort lists. Boolean values like Yes/No
switches and multiple choice variables are not supported in this
release).

• building a table of replacement parameter values

• creating replica flows with automatic dataset name generation

• managing the replication and job submit in a job status matrix

• chaining flows based on successful completion of pre-requisite flows

Flow replication values are stored in flat files in the Project and Template
flow directories.

The flow replication attempts to keep the information in the flat files and
the actual replica flow information synchronized. As you create and delete
flows and datasets on disk, the corresponding information is also created
and deleted in the flat files (as long as you do all creating and deleting in
the SeisSpace® User Interface.)

We have attempted to keep this synchronization in place for a variety of
things that users may decided to do, such as renaming templates or
renaming lines, etc. We believe that many of these types of activities can be
handled but recommend that you try to keep these actions to a minimum.

Note: The synchronization will not remain intact if you delete directories
and/or files off of disk outside of the navigator. At this time, it is difficult to
delete information in the flat files that is left stranded there by manually
deleting information from disk.

Flow Replication Components

Many of the Flow Replication components are shown below. These include
a flow in template mode in the editor, a tree view of the columns in the
replica table and a validation table. The other components, not shown here,
are the replica table of replacement values, and the job status table.
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The tree view of the contents of the replica table can be opened with the

Replica Tree icon.

The validation table can be opened with the Validate Template

Parameters (V) icon.

A general workflow is:

•  Convert a flow to a template using the toggle icon. ,

•  Select the parameters in the flow that will change from job to job,

•  Populate the replica table columns with the parameter values for
each job,

Replica Tree

Validation Table
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•  Set the values of the parameters in the template flow by select the
replica table column heading names from the Replica Tree view pane
of the Flow Editor,

•  Validate that the replacement strings are correct, and

•  Generate (build) and execute the replicated flows.

Building Templates

A template is a flow that is used as a master to make copies from. The
template flow is copied and the selected parameters are changed in each
copy (or Replica). It is always a good idea to run the template flow as a test
and make sure that the flow runs and generates the desired results given one
set of replica parameters.

Note: When a Template flow is submitted, it will use the parameters behind
the yellow boxed replacement strings. i.e. the value in the menu if the
yellow replacement box is not there.

Converting a flow to a template and back to a flow

In the flow editor, you can toggle the status of a flow between being a
normal Flow and a Template using the View > Templatize / Detemplatize
Flow pulldown menu, or the Templatize or detemplatize flow

icon.

When you change a template back to a normal flow, all components of any
previously created replica flows will be deleted and the template column
will be deleted from the Replica Job Table.
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Selecting parameters to change from job to job

To select a parameter as one that will have its value changed from job to
job, click on the circle next to the parameter name. A yellow box will
replace the standard parameter input.

Populate this yellow box with the values that will change by using a
combination of text and column selections from the replica table
spreadsheet. The replica table will be described in the next section.
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To display only selected parameters in table view or in individual process
dialogs, select View > Toggle Show Selected Only pulldown menu or the

Toggle Show Selected Only icon.

The first time you convert a flow to a template and set some replication
parameters, you will need to save the flow. The flow will also be annotated

as a "Template" flow icon in the tree and table views.

All of the replication information is saved with the flow. The folder icon in
the tree and table views will revert back to a standard folder if the flow is
no longer considered to be a template.

Opening and Editing The Replica Table

To open a replica table for a line click the Replica Editor icon . If
this is a new table, a new replica table containing no values is opened and
you are prompted to add rows. Click OK to dismiss the window. The R
icon is available when a Line level project, datasets, flows, or tables folder
is selected in the Tree view or the table view or from the flow editor. Note:
A different replica table exists for each line and you can have multiple
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replica tables open at the same time. The replica table for the line that is
active in the navigator or flow editor will be active in the replica editor tab.

The replica table has two tabs: the Replicas tab and the Constants tab. The
constants tab can be used to set values you want everyone to use all the
time that differ from the menu defaults. Examples might include a specific
ramp length for mutes or a specific stretch percentage value for NMO. The
replica tab will be populated with the values that will change for the
parameters you want to change from job to job.

The Subproject column is used for setting the names of the lines (or
subprojects) for writing the replica flows to if you select that option in the
Job Table tab. This is common for 2D work where you need the put the
replicated flows in different lines.
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Adding Rows and Columns

Use MB3 inside the empty replica table for the options menu.

Adding rows

Click Add Rows and enter a number of rows to add for your table.
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Adding Columns

Use MB3 to open the options menu and select Add Column.



Replicating Flows153 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

Enter the column name and type into the Add Column dialog. The name
of the column may reflect the process and/or parameter that will have
different values from job to job. Typical column names might be min_shot,
max_shot, min_cdp, max_cdp. The three types are: String, Integer or
Float. You can also add a text description of the column. You cannot
change the data type of a column after it is created.

Note: The replica table will allow you to use column names with blank
spaces, but it may help with formatting later to avoid using blanks. For
example:

instead of using a name like: line min

use a name like:                    line_min    or   min_line

You can add the column to the left side or right side of the table. The
default is set to add new columns to the left. This means that the older
columns will be pushed off the right side of the display as time progresses
and as you add more and more columns.

Deleting Rows and Columns

Deleting rows

Select some cells in the rows that you want to remove and then choose the
Remove Rows option from the MB3 menu or use the Icons to delete the

rows in the replica table spreadsheet.



Replicating Flows154 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

When you delete rows you are prompted for a response on what to do with
Replica flows that may have been built against these rows for some
templates.
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Delete stranded replicas

Delete any replica flows for these sequence numbers when you delete the
rows.In general, to make sure that there are no replica flow files left over on
disk, this option should be selected.

Proceed without deleting

Delete the rows but do not delete any replica flows that may exist for any
template for these rows. The replica flow files will remain on disk but will
become "stranded" and will be not be presented in the Replica Job Table.

Cancel

Cancel the row delete operation and do nothing.

Deleting Columns

Select some cells in the column that you want to remove and then choose
the Remove Columns option from the MB3 menu or use the Icons to
delete the columns in the replica table

spreadsheet.

Populating Integer or Float Columns

Enter a starting value and increment into the Fill Column dialog. Starting
values can be either integer or floating point.

Populating String Columns

The Fill Column dialog allows you to build an expression based on text
constants, numerical sequences and other values in the replica table. You
can use the >> and << icons to toggle the tree view on and off where you
can choose to use values that exist in the replica table.
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There are three ways that you can add in text or numerical sequences to
build the strings that you want to populate the column with: String of
Characters, Incrementing Numbers and Values from the Replica Table.

The best way to learn to use this tool is to experiment with adding in string,
numeric and replica table values and watch the way the strings build up in
the QC window.

Add expressions to the final string by using the + icons.

You can Edit, Delete, or Clear values and arrange the text and numerical
sequences.

Select OK to fill the cells with the current strings and close the fill window.

Select Apply to fill the cells with the current strings.

Select Cancel to cancel the fill operation.

If you want to edit an existing entry, you will find that there is a check mark
and an X next to it. You can accept your changes using the check mark and
abort the edit with the X.

String of
Characters

Incrementing
Numbers

Values from
the Replica Table

Expand to show
the replica tree

QC window



Replicating Flows157 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

Populating the Constants Table

The Constants Table is a single value per variable.

Give the constant a Name and a value and an optional description. For
example: you may choose a constant name of mutelen and a value of 24
with a description of "mute length".
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Saving the Replica Table

The Replica Table is stored in a flat file. You are required to Save the
contents of the Replica Table manually. An "*" will appear in the title bar
of a replica table pane if un-saved edits exist in the table.

Special replica table syntax for some parameters

Some paramters requires special syntax for the replacement strings. These
include multiple choose and pop-choose parameters.

For choose parameters such as pop choose and circular choose

Type in the descriptive name of choice presented in menu. Case and
whitespace are ignored. For example:

If the choices are:

"RMS", "Mean", "Median" or "Time variant"

Then to choose "RMS" any of these specifications are equivalent:

RMS    ,    rms    or    rmS

To choose "Time variant" any of these specifications are equivalent:

   Time Variant    ,    TimeVariant    or    Time  variant

For Multiple choose parameter:  (such as the attribute to choose in Trace
Statistics)

This is the same as single choose except that you specify multiple choices
delimited by one or more space.  If you want to specify a choice that has
embedded blanks you need to quote it with a ^.  Note that we use a ^
instead of a double quote. For example,  if the choices are the same as
above.

Then to choose "RMS",  "Median", and "Time variant",  any of these
specifications are equivalent:

Rms Median timevariant

median  RMS ^time   variant^

^Time Variant^ Median RMS

For Boolean parameters.   Like the others, case is ignored.
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To choose "Yes", specify:

Yes or true

To choose "No", specify:

No or false

Choosing Replica Parameters in the Template Editor

After you have chosen which parameters will change from job to job and
have populated the replica table, you need to tell the template which
parameters to use. This is all accomplished in the Flow Editor tab.

This example shows that two process parameters have been selected to
change from job to job. One "yellow box" is populated with a combination
of text and replica values or constants. The other is a constant.
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You can drag and drop the replica table column names into the template
from the tree view. To enable the tree view click on the Replica Tree

icon.

Click Refresh on the Validation table to verify the changes and then check
the value that will be used for each flow replica to be built.

Naming Conventions

Replacement values have the following naming conventions:

c.xxxxxx is a constant

r.xxxxxx is a replica table column

s.xxxxxx have the template name and project name available

Add additional text by including it in double quotes and + signs as
separators.

Selections are concatenated together with + signs. For example, a Replica
Table with columns of min_line and max_line, can be used to name the
output data files based on a line range. The the following string can be used
for the output naming convention:

“output” + r.min_line + “-” + r.max_line

This creates the following output dataset names:
output1-10
output11-20
...
output91-100

Reading data from other Area / Line’s in DDI

There is a special case for setting up a series of replicated flows where the
input step in each flow will read a different dataset from a series of
different Area / Lines. To build the input string to handle this case build a
string in the Disk Data Input - Select Dataset parameter that has the Area
Line and Dataset information separated by the "pipe" or "|" symbol. For
example:

If you have a series of datasets called Data under a series of different lines
under the same area,

AREA
/ Line1 ----> Data
/ Line2 ----> Data
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/ Line3 ----> Data
::::::::::::::::::::::
/ Linen ----> Data

you can build a template in a different line to read these datasets by
specifying the string   "AREA " +"|"+ "Line"+r.seq +"|" + "Data". Make
sure that you don’t have any extra blank spaces around the pipe symbols.

Template Editor and String Validation Table

The validation table can be opened with the Validation Table icon.
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If you select a cell or series of cells in the replica table, that parameter in
the flow editor where it will be outlined in a white box.

Build and Submit jobs using the Replica Job Table

Replica Job Table Overview

The Replica Job Table is used to build, submit and monitor replicated
flows. Open the Replica Job Table by clicking on the Replica jobs

icon.

If no templates exists, the table is initialized with two columns: the
sequence number and the subproject columns. The subproject is blank if
you did not populate it in the Replica Table.
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Any Active Template will appear as a column in the Job Table after you
convert a flow to a template and save it. You do not need to save it every
time you change it while it is in the editor to validate the replica parameters
or make replicas from it. The validation table and job table use the
information in memory related to the template in the flow editor. However,
you need to save the template when you are finished with it to save all of
the processes, parameters, and replication parameters. You will also find
that you need to save the template if you change the chaining pre-cursor
specifications.
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You can remove a template from the job status table by either unchecking it

in the column selector which is activated by the icon. and presents
a dialog box to choose the columns to display

or by "de-templatizing" the flow by clicking on the Templatize or

detemplatize the flow icon.

Note: Replication substitution parameters and equations are saved with the
flow.

• Share this Project

This option determines where the replicas will be built. If this option
is checked "ON", then the replicas are build for use in the same
subproject (or LINE) as the template. If this option is not checked or
"OFF" then the replicas are written to and build for use in the
associated subproject. (Common for multiple 2D line work)

• Autoscroll Table

When you select a long list of flows to built, or build and submit, the
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RJT can be set to autoscroll as the flows are being built or submitted.
The default behavior is to not scroll the list.

There are two views of the data stored for the Replicas, The standard
Replica Job Table and the Sideways-Replica Job Table. (RJT and S-RJT).
In the RJT you can choose a single attribute of the jobs to display. In the S-
RJT you can choose to display all attributes of the replicas for multiple
templates in separate tables.

There are many different attributes you can choose to display for the
replicas in the Job Table:

The S-RJT can be activated by selecting cells in the RJT and then clicking

on the Detaled View icon.  to start the S-RJT.
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A separate table will be presented for each template selected.

There are many different values for the Job Status attribute. The different
possible values are color coded as shown below:

• Unknown  - Job status unknown - info not in sitemanager and/or
jobs.stat file is not found

• Build Pending   - has been selected to be build and/or submitted,
Operation in progress

• Built  -Replica flow has been built

• Build Failed  - the build of the replica failed - usually related to a
problem in the replacement strings in the template - Go back to the

RJT

S-RJT
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flow builder and use the Validation procedure to resolve the replace-
ment string problem

• Chain Failed  - The precursor to this job failed - so the chaining was
stopped. This job may still be OK.

• Submit Pending - has been chosen for build/submit operation and the
operation is in progress

• Submit Failed - The precursor to this job is probably in an Unkonwn
state - so the chaining was stopped. This job may still be OK.

• Queued - Job is in the Queue

• Chained - job is waiting to be submitted pending completion of its
precursor flows

• Initializing - job has released from the Q and is in the initialization
phase

• Running - job has released from the Q and is in the running phase

• Completed - Job has completed normally

• Failed - Job failed - any jobs that were chained to this flow will now
show Chain Failed

• Cancelled - Job was cancelled either from a Queued or Chained state

• User Terminated - Job was terminated by the user after it was in
eithere Initialized or Running state

•

If you replicated into other lines (un-checking Share this Project) then there
will be a folder icon to the left of each of the above indicating that these
flows are being built in another line.
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All tables except the Job Status table show the job status only as a color
code with accompanying icon but shows the alternate information.

Building jobs

To build jobs, select cells in the Job table by "painting" them while holding

down MB1 and then select the Build a Replica Flow icon. You can
also use the MB3 - Build from the options menu.

You can watch the job building status in the xterm console that was used to
start the Navigator and watch the cell status change. The Build Pending
status indicates that the cell was selected to be built but the building
process has not progressed to that point yet.

You can use the Stop icon to stop the build, build and submit or submit
procedures.

To refresh the contents of the Replica Job Table, click on the Refresh

icon .

You will also notice that Replica Flows are visible in the navigator in the
table view when a Template flow is selected in the tree.

The replicated flows have two different names, the DescName (or
descriptive name that you normally address the flows by plus the actual
disk directory name where the packet file and job.outputs are stored.

Flow Replication Information Storage

All data associated with flow replication are stored in flat files in the
$PROMAX_DATA_HOME/AREA/LINE and
$PROMAX_DATA_HOME/AREA/LINE/FLOW directories

LINE/

replicaParms.txt
tab-delimited file with replica parameters--editable in Excel; can be a symbolic link
replicaParms.txt~
a backup that is generated whenever a repilcaParms.txt file is successfully loaded
replicaPrefs.xml
some constants stored about the replica table such as column width and display order

LINE/FLOW (template flow)

exec.#.pwflow ---
exec.#.log      |files associated with the template itself
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exec.#.qsh      |There may be multiple versions depending
exec.#.qerr     |on how many times the template was run to test it
packet.#.job ---

jobs.stat   ---   This file is not used at this time but contains
                  the status of the main flow

exec.r#.#.pwflow --- files associated with each replica flow
exec.r#.#.log      | The first # after the r is the sequence number
exec.r#.#.qsh    --- The second # is the replica instance number

replicas.#.stat --- a binary file that contains all of the job status
                      information replicas of a particular version

replicasInfo.xml --- a simple XML file that indicates that the flow
is a template. This file also stores the user defined

                     descriptive names of the replica flows for this
                     template

The general methodology follows the idea that it is possible that some of
the replicas will need to be rerun or rebuilt and rerun for a variety of
different reasons. After you either rerun or rebuild/rerun some of the
replicas you will see multiple versions of the flow, printout and qsh files for
each instance of the replica and multiple replica.#.stat files. In the
following example replicas 1 and 2 have been built and run 4 times,
replicas 3 and 4 have been run 3 times etc....

$ ls exec.r1.*
       exec.r1.2.log exec.r1.2.pwflow exec.r1.2.qsh exec.r1.3.log
exec.r1.3.pwflow exec.r1.3.qsh

$ ls exec.r2.*
       exec.r2.2.log exec.r2.2.pwflow exec.r2.2.qsh exec.r2.3.log
exec.r2.3.pwflow exec.r2.3.qsh

$ ls exec.r3.*
       exec.r3.1.log exec.r3.1.pwflow exec.r3.1.qsh exec.r3.2.log
exec.r3.2.pwflow exec.r3.2.qsh

$ ls exec.r4.*
       exec.r4.1.log exec.r4.1.pwflow exec.r4.1.qsh exec.r4.2.log
exec.r4.2.pwflow exec.r4.2.qsh

$ ls exec.r5.*
       exec.r5.0.log exec.r5.0.pwflow exec.r5.0.qsh exec.r5.1.log
exec.r5.1.pwflow exec.r5.1.qsh

$ ls exec.r6.*
       exec.r6.0.log exec.r6.0.pwflow exec.r6.0.qsh exec.r6.1.log
exec.r6.1.pwflow exec.r6.1.qsh

$ ls exec.r7.*
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       exec.r7.0.log exec.r7.0.pwflow exec.r7.0.qsh

$ ls exec.r8.*
       exec.r8.0.log exec.r8.0.pwflow exec.r8.0.qsh

$ ls exec.r9.*
       exec.r9.0.log exec.r9.0.pwflow exec.r9.0.qsh

$ ls exec.r10.*
       exec.r10.0.log exec.r10.0.pwflow exec.r10.0.qsh

$ ls -al *stat*
 -rw-rw-rw- 1 user1    users         312 Jun  1 10:52 jobs.stat
 -rw-rw-rw- 1 user1    users        1716 Jun  1 10:33 replicas.0.stat
 -rw-rw-rw- 1 user1    users         936 Jun  1 10:40 replicas.1.stat
 -rw-rw-rw- 1 user1    users         624 Jun  1 10:44 replicas.2.stat
 -rw-rw-rw- 1 user1    users         312 Jun  1 10:58 replicas.3.stat

Notice that the earlier numbered replicas such as 1 and 2 have instance
numbers 2 and 3 where as replica numbers 3 and 4 have instance numbers 1
and 2. There is a preference setting that can be used to put a limit on the
number of versions of replicas to keep. In this case the preference was set
to keep and automatically purge to 2 versions of the replica flows. The two
most recent are retained.

The job status information for all of these versions is stored in the different
replicas.#.stat files. The status that is shown in the RJT (Replica Job Table)
will be the status of the flow in the matching numbered stat file. The
replica.3.stat file will only have information for those flows that had a 3rd
instance. The stat files contain the Job status such as Complete, Failed,
User Terminated. The "Built" and "Unknown" status’ are not stored. A flow
is marked as Built if there is no known status for it in the matching stat file
and the flow files exist on disk. If multiple versions of replicated flows
exist, the status that will be shown is the status in the stat file of the highest
numbered replica.

          sequence number
                     1 1 1 1 1
   1 2 3 4 5 6 7 8 9 0 1 2 3 4
   ---------------------------
   . . . . x . . . x . . . . .    2.stat
   . . . x x . . . x x x . . .    1.stat
   x x x x x x x x x x x x x x    0.stat

If you delete a replica using the delete function in the RJT, all existing
instances of the replicated flows will be deleted and the job status will be
removed from all of the stat files. For example, if the replica flows for
sequence 5 are deleted, the status will be removed from all existing stat
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files. The status of the flow will be set to "Unknown" until the replica is
rebuilt.

          sequence number
                     1 1 1 1 1
   1 2 3 4 5 6 7 8 9 0 1 2 3 4
   ---------------------------
   . . . . . . . . x . . . . .    2.stat
   . . . x . . . . x x x . . .    1.stat
   x x x x . x x x x x x x x x    0.stat

If you delete all of the replicas all of the replica flow folders will be deleted
but the replica.#.stat files will not be deleted. All of the status values in all
of the stat files will be deleted.

          sequence number
                     1 1 1 1 1
   1 2 3 4 5 6 7 8 9 0 1 2 3 4
   ---------------------------
   . . . . . . . . . . . . . .    2.stat
   . . . . . . . . . . . . . .    1.stat
   . . . . . . . . . . . . . .    0.stat

If you make a new set of replicas the instance numbering will start at 0
again.

If there are no replica flows left in the template flow directly you can safely
delete all of the stat file is you want to.

Viewing Replicas in the Navigator

The DescName is under user control. When you build the flows you can
either use the default name which is a concatenation the first 10 squished
characters of the template name with the sequence number appended, or a
name that you have built in the replica job table. In either case the actual
directory name is a concatenation of "exec.r#.#.pwflow" as previously
described

For example, in the picture below notice that the template name is "pure
pm 2 templaate". The replicated flows have a the default names that are the
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concatenation of part of the original template name and the sequence
number..

Automatic Dataset Generation

If the replicas are all to output different datasets, these datasets names will
be automatically generated when the replica flows are built. Choose the
Output Dataset Filename a a parameter to change from one replica to the
next and input the desired output dataset name string definition.
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When the replica flows are built, the output datasets will be created and
added to the datasets list.

You must select the output dataset name in the menu as a replacement
variable for the dataset stubs to be created and added to the datasets list.
(This is different behavior from ProMANAGER) . This is true for the 2D
case where each replica manufactures the same dataset in the other lines (if
sharing is set to no). In the case where all of the replicas write the same
dataset name in each line, set the replacement value to the descriptive name
of the dataset.

The datasets are not deleted when the replica flows are deleted or when the
Template flow is de-templatized (or turned back into a standard flow). The
output datasets need to be managed manually.
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Building New Subprojects

If you select to NOT "Share this Project" then you will create a series of
new subprojects under the current project and the flows and datasets will be
created in the new subprojects.

Submitting jobs

To submit jobs, select the cells and click on one of the Job Submit icons.
Jobs are submitted in the order they were selected. The Job Table will also
display the status of the jobs as they progress through the system. You can
also use MB3 to get job submit options.

Deleting Replicas

You can delete the replica flow in the Navigator tab or you can delete them
from the job status table.

Delete is an option from the MB3 options dialog.

If you delete the replicas from the Navigator table view, you will need to
refresh the display of the Replica Job Table (RJT) to see that they were
deleted.
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Flow Chaining

Chaining flows together means that a flow will not be submitted until
another flow completes, or multiple other flows complete successfully. The
concept of chaining flows together exists for normal flows as well as
replicated flows build from templates.

To chain flows together you simply tell a flow which other flow (or flows)
must complete before it can be submitted for execution.This list of pre-
requisite flows is added to the parameterization of the <Flow> executive
process at the beginning of the flow list of processes.

Chained Flows

The simplest example of flow chaining involves two flows where the first
flow must complete before the second flow is submitted. In this example
flow "man05..." creates an output dataset and flow "man08..."  then reads
that dataset for further processing work and writes a new dataset. In this
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case you tell flow "man08..." that it has a pre-requisite flow called flow
"man05..".

In the parameter dialog for the <Flow> "executive process" of  the second
flow enter the name of the first flow as the precursor flow.

When you submit the first flow to the Queue, it will run as a standard flow
and will progress from Queued to Running to Completed status. When you
submit the second flow to the Queue, it will not be put into the Queue until
Flow 1 completes and will show in the job viewer with a "Chained" status.

After the first flow completes, the second flow will be added to the Queue.
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If Flow 1 fails or it is terminated, Flow 2 will receive a "Chain Failed"
status and Flow 2 will not be added to the Queue.

Chained Replicas (one to one)

The next common example of chaining flows together involves two sets of
replicas where there are an EQUAL number of replicas from two different
templates where the second set of replicas are dependent on the first set
completing.

In this example there are two templates, "template 1" and "template 2"
where the replicas built from template 2 are dependent on a successful
completion of the replicas built from template 1.
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In this case "template 1" is added to the Chain precursor parameter of the
<Flow> process in template 2.

From the RJT (Replica Job Table) select a series of replicas to work with
from both columns (template 1 and template 2). You may choose to build
them and submit in a separate step or you may choose to build and submit
in one step. In either case you will see that the replicas that were built for
template 1 will be sent to the Queue but the replicas for template 2 will
inherit the "Chained" status.

As the replicas for template 1 complete, the replicas for template 2 will be
added to the QueueChained Replicas - "many to one" and "many to fewer"
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Chained Replicas (many to one) or (many to fewer)

There may be cases where you don’t have an equal number of replicas for
chained templates. An example might be where you want to run 100
replicas for one template and then run a single job that is dependent on all
100 completing. In this case you would set the chain precurson to
template1[1-100]

Another example might be where you would run 100 jobs and output to
100 datasets and then run 50 jobs, each reading two input datasets in the
next processing step. In this case you need to tell each replica of the second
template that they are each dependent on multiple replicas of the first
template.

Two templates and their Validation Tables are shown below. The first
template is set up to make 10 replica flows and output 10 different data
files. The second template is set up to make 5 replica flows each reading 2
input files from the first set of replicas. Template 2/Replica 1 is dependent
on the two flows Template 1/Replica 1 and Replica 2 completing
successfully. In this case the syntax:

"template 1["+r.seq*2-1+"-"+r.seq*2+"]"
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is used as a value that changes from replica to replica in the <Flow>
process parameterization.



Replicating Flows181 Using the SeisSpace® Processing System

Known ProblemsOther DocsOther Docs Search Page

In this case there will be 10 jobs for the first template but only 5 jobs for the
second template in the RJT.
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Chained Replicas - "one to many"

There may also be cases where you want a set of replicas to be sent to the
Queue after a single job completes.For example, you may want to run a
series of Stack jobs but you need a Velocity Manipulation job to run first.

For this example you will need to build two templates: 1) for the Velocity
Manipulation job where there will be only 1 replica made and 2) for the
stack jobs where there will be many replicas all dependent upon the one
velocity manipulation replica job completing successfully.

Note below that the Velocity Manipulation template has no replacement
values since there will only be one replica manufactured from it.

Also note that the Chain precursor in the stack template is parameterized
with the syntax

velmanip[1]

which means that each of the replicas produced from the stack template is
dependent on the first replica sequence of the velmanip template.
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In the Replica Job Table you will then built the first sequence replica of the
velmanip template and all of the replicas for the stack template.

The stack replicas can be submitted, to a "Chained" state after the one
velmanip replica is submitted to the Queue. After the Velmanip replica job
completes, the stack replicas will be added to the Queue for execution.

NOTE: the chaining is available for Flow to Flows or from Replicas to
Replicas, but there is no chaining relationship for Replicas to Flows and
vice versa.
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Chained Replicas - previous sequence number

Another case of flow chaining may be where you want to force the different
sequence numbers of replicas from the same template to run serially and be
dependent upon the previous sequence number replica completing
successfully.

An example of this may be where you want to run a series of jobs to do the
External Model Correlation where each job has to run separately to write to
the database.

For this example the Chain precursor parameter in the Flow process is set
to be dependent on the previous replica sequence from the same template.
In this example the template is named "EMC picking template", with the
precursor parameter is set to

"EMC picking template["+r.seq-1+"]"

Each replica will be queued up in sequence as the previous sequence
completes successfully. The references to replica numbers less than or
equal to 0 will be ignored so if the first line resolves to EMC picking
tempate[0]. This job does not have any pre-cursor and the first replica will
run as soon as it can be released from the Queue.

This can be used to manage a job series of 1000 jobs as an example where
you can set the replication string for the precursor to:

"EMC picking template["+r.seq-10+"]"

in which case the first 10 jobs will create dependences of EMC picking
template[-9] through [0]. All of these will be treated as not having
precursors and the first 10 jobs will release as soon as they can. The
remaining jobs will be queued up as the previous sets complete so that only
10 jobs will run at any given time but you wont clog up the Q with
thousands of jobs. As 1 completes 11 will release, then 21 etc. as will all of
the other sequences.
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Enabling and Disabling Replicas

As seen in the examples above you will likely end up with different
numbers of replicas for different templates. You may choose to use the
Replica Enable/Disable feature to mask out replicas that are not needed.
You can highlight (select) a series of rows in a replica column and use the
MB3--> Enable/Disable Replicas option to indicate cells that should not
contain replica.

This is a convenient method for indicating which replicas should exist for
each of the templates.
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Chained Replicas - alternate areas/lines

There may be cases where one set of replicas are dependent on another set
of replicas in other lines or other area/lines. In this example template 1 is in
line "Flow Chain -1" and writes datasets "synth-1 to n" into line "Flow
Chain -1". The second template is the "read data template" in line "Flow
Chain -2" and is dependent on the replicas in "Flow Line -1" to complete
and the datasets to exist.
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This example shows that the replicas for Flow Line -1 are built and the
replicas for Flow Line -2 are in a Chained state waiting for the first set of
replicas to complete.

To set the chaining pre-cursor for this scenario you can use the Area / Line
/ Template syntax in the chain precursor parameter:

Test Area / Flow Chain -1 / template 1
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The dataset selection uses the AREA | LINE | dataset syntax to access the
datasets from line "Flow Chain -1"

NOTE: in the chain precursor the AREA is optional if the alternate line is
in the same AREA. In this case "Flow Chain -1 / template" is equivalent to
"Training Data / Flow Chain -1 / template" since both lines Flow Chain -1
and Flow Chain -2 are under the same AREA.
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Glossary

Cluster A set of nodes connected by a dedicated network.

Node An individual computer or host in a cluster.

Mayor node
Manager node
Head node

A cluster node that is reserved by the manufacturer for
administrating the other nodes. This node usually has more
disk and more RAM than nodes reserved for distributed
computation. This node is a good location to run the
sitemanager and the other management daemons such as the
Queue servers. Not all clusters have a specific management
node, so one compute node is reserved for such tasks.

Foreman node A foreman joblet that does any work that cannot be
distributed. For instance, SEGY input is read only by the
foreman and shared with peers. The foreman should be not
assigned to an already busy node, such as the manager.

iSitemanager A server that provides information for all project and users
at a given site. This is the SeisSpace® directory service.The
sitemanager stores information about the jobs that have
been submitted and manages the shared information in the
netdir.xml file

NetDir (netdir.xml) A database of information managed by the SiteManager. It
is a file on disk that is continuously updated.

Administrator Privileges Privileges allow you to setup cluster and project
configuration.

Job Viewer A tool on the systems menu that tracks jobs that are
submitted, executing, completed or failed.

Log Viewer A tool that presents the job output logs to the screen.

 ProMAX® project Equivalent to a PROMAX_DATA_HOME

joblet Parallelized processing flows running on different hardware
nodes. Each joblet generally processes a separate subset of
the input data, but joblets can exchange information and
data with their distributed peers. More than one joblet can
run in a single hardware node to take advantage of dual
CPUs. (You specify the number of joblets per node when
submitting the job.).
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